## Contents

### 1 Safety

Electrical Safety ....................................................................................................................................................... 12
  General Guidelines ........................................................................................................................................ 12
  Power Cord .................................................................................................................................................... 12
  Emergency Turn Off .............................................................................................................................. 13
  Laser Safety .............................................................................................................................................. 13

Operational Safety ............................................................................................................................................. 14
  Operational Guidelines ........................................................................................................................ 14
  Ozone Release .......................................................................................................................................... 14
  Printer Location ......................................................................................................................................... 14
  Printer Supplies ......................................................................................................................................... 15

Maintenance Safety ........................................................................................................................................ 16

Printer Symbols ............................................................................................................................................. 17

Environmental, Health, and Safety Contact Information ........................................................................ 18

### 2 Features

Parts of the Printer ........................................................................................................................................... 20
  Front View .................................................................................................................................................. 20
  Rear View .................................................................................................................................................. 21
  Internal Parts ........................................................................................................................................... 22
  Control Panel ............................................................................................................................................ 23

Energy Saver Mode ......................................................................................................................................... 25
  Exiting Energy Saver Mode ................................................................................................................... 25

Information Pages ......................................................................................................................................... 26
  Configuration Report ............................................................................................................................. 26
  Printing a Configuration Report ........................................................................................................ 26

Administrative Features ............................................................................................................................... 27
  CentreWare Internet Services .............................................................................................................. 27
  Finding the IP Address of the Printer ................................................................................................. 27

More Information ......................................................................................................................................... 29

### 3 Installation and Setup

Installation and Setup Overview ................................................................................................................... 32

Selecting a Location for the Printer ........................................................................................................... 33

Connecting the Printer ................................................................................................................................. 34
  Selecting a Connection Method ............................................................................................................. 34
  Connecting to a Computer Using USB ................................................................................................. 35
  Connecting to a Wired Network ........................................................................................................... 35
  Finding the IP Address of the Printer .................................................................................................... 35
  Connecting to a Wireless Network ....................................................................................................... 36
## Contents

Connecting to a Telephone Line .................................................................................................................. 39
Configuring Network Settings ...................................................................................................................... 40
  About TCP/IP and IP Addresses ........................................................................................................... 40
Enabling the Printer for Scanning .............................................................................................................. 41
Installing the Software ................................................................................................................................. 42
  Operating System Requirements ........................................................................................................... 42
  Installing the Print Drivers for a Windows Network Printer ................................................................. 42
  Installing the Print Drivers for a Windows USB Printer ........................................................................ 43
  Installing Print Drivers for Macintosh OS X Version 10.5 and Later .................................................... 44
  Installing Scan Drivers for Macintosh ..................................................................................................... 45
  Installing Drivers and Utilities for UNIX and Linux .............................................................................. 45
  Other Drivers ......................................................................................................................................... 46
Installing the Printer as a Web Service on Devices ................................................................................... 47

### 4 Paper and Media

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Paper</td>
<td>50</td>
</tr>
<tr>
<td>Recommended Media</td>
<td>50</td>
</tr>
<tr>
<td>Ordering Paper</td>
<td>50</td>
</tr>
<tr>
<td>General Paper Loading Guidelines</td>
<td>50</td>
</tr>
<tr>
<td>Paper That Can Damage Your Printer</td>
<td>51</td>
</tr>
<tr>
<td>Paper Storage Guidelines</td>
<td>51</td>
</tr>
<tr>
<td>Supported Paper Types and Weights</td>
<td>52</td>
</tr>
<tr>
<td>Supported Standard Paper Sizes</td>
<td>52</td>
</tr>
<tr>
<td>Supported Paper Types and Weights for Automatic 2-Sided Printing</td>
<td>53</td>
</tr>
<tr>
<td>Supported Standard Paper Sizes for Automatic 2-Sided Printing</td>
<td>53</td>
</tr>
<tr>
<td>Supported Custom Paper Sizes</td>
<td>53</td>
</tr>
<tr>
<td>Loading Paper</td>
<td>54</td>
</tr>
</tbody>
</table>
  Loading Paper in the Bypass Tray                                          | 54   |
  Loading Small Paper Sizes in the Bypass Tray                              | 57   |
  Configuring Trays 1–4 for the Paper Length                                | 59   |
  Loading Paper in Trays 1–4                                                | 61   |
  Configuring Tray Behavior                                                 | 63   |
| Loading Paper in the Bypass Tray                                          | 65   |
| Printing on Special Paper                                                | 68   |
  Envelopes                                                                | 68   |
  Labels                                                                    | 72   |
  Glossy Cardstock                                                         | 73   |

### 5 Printing

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Overview</td>
<td>76</td>
</tr>
<tr>
<td>Selecting Printing Options</td>
<td>77</td>
</tr>
</tbody>
</table>
  Print Driver Help                                                         | 77   |
  Windows Printing Options                                                  | 77   |
  Macintosh Printing Options                                                | 79   |
| Printing Features                                                         | 80   |
  Printing on Both Sides of the Paper                                       | 80   |
Contents

6 Copying ................................................................. 91
Making Copies ........................................................................................................ 92
Document Glass Guidelines ................................................................................. 93
Copying an ID Card ............................................................................................... 93
Duplex Automatic Document Feeder Guidelines ................................................. 94
Adjusting Copying Options .................................................................................. 95
Basic Settings ...................................................................................................... 96
Image-Quality Settings ......................................................................................... 97
Output Adjustments .............................................................................................. 98

7 Scanning ........................................................................................................... 101
Loading Documents for Scanning ....................................................................... 102
Document Glass Guidelines ................................................................................. 102
Duplex Automatic Document Feeder Guidelines ................................................. 103
Scanning to a USB Flash Drive ........................................................................... 104
Scanning to a Folder on a USB Connected Windows Computer ....................... 105
Scanning to a Folder on a USB Connected Macintosh Computer ....................... 106
Scanning to a Shared Folder on a Network Computer ........................................ 107
  Sharing a Folder on a Windows Computer ......................................................... 107
  Sharing a Folder Using Macintosh OS X Version 10.5 and Later ....................... 108
  Adding a Folder as an Address Book Entry Using CentreWare Internet Services 108
  Adding a Folder as an Address Book Entry Using the Address Book Editor ...... 109
  Scanning to a Folder on a Network Computer .................................................. 109
Scanning to an Email Address ........................................................................... 110
Scanning to Web Services on Devices ............................................................... 111
Scanning Images into an Application on a USB Connected Computer ............... 112
  Scanning an Image into an Application ............................................................ 112
  Scanning an Image Using Windows XP ............................................................ 112
  Scanning an Image Using Windows Vista or Windows 7 ................................... 113
Contents

Adjusting Scanning Settings ................................................................................................................. 114
  Setting the Output Color .................................................................................................................. 114
  Setting the Scan Resolution ............................................................................................................ 114
  Selecting 2-Sided Scanning .............................................................................................................. 115
  Setting the File Format ................................................................................................................... 115
  Making the Image Lighter or Darker ............................................................................................... 115
  Adjusting the Sharpness .................................................................................................................. 115
  Adjusting the Contrast ...................................................................................................................... 116
  Specifying the Original Size ............................................................................................................ 116
  Erasing Edges .................................................................................................................................. 116

8 Faxing .................................................................................................................................................. 117
  Configuring the Printer for Faxing .................................................................................................. 118
  Loading Documents for Faxing ....................................................................................................... 119
  Sending a Fax from the Printer ......................................................................................................... 120
  Sending a Delayed Fax ................................................................................................................... 121
  Sending a Cover Page with a Fax .................................................................................................... 122
  Sending a Fax From Your Computer .............................................................................................. 123
    Sending a Fax Using Windows Applications .............................................................................. 123
    Sending a Fax Using Macintosh Applications ............................................................................ 124
  Printing a Secure Fax ....................................................................................................................... 125
  Polling a Remote Fax Machine ........................................................................................................ 126
  Manually Sending, Receiving, or Polling Using OnHook ................................................................. 127
    Manually Sending, Receiving, or Polling Using OnHook .......................................................... 127
  Editing the Fax Address Book .......................................................................................................... 128
    Adding or Editing Contacts in the Fax Address Book in CentreWare Internet Services .......... 128
    Adding or Editing Groups in the Fax Address Book in CentreWare Internet Services .......... 128
    Adding or Editing Contacts in the Fax Address Book at the Control Panel ............................ 129
    Adding or Editing Groups in the Fax Address Book at the Control Panel ............................ 129
    Using the Address Book Editor Utility ......................................................................................... 129

9 Maintenance ......................................................................................................................................... 131
  Cleaning the Printer .......................................................................................................................... 132
    General Precautions ...................................................................................................................... 132
    Cleaning the Exterior ..................................................................................................................... 133
    Cleaning the Scanner ..................................................................................................................... 133
    Cleaning the Interior ..................................................................................................................... 135
  Ordering Supplies ............................................................................................................................. 136
    Consumables ................................................................................................................................. 136
    Routine Maintenance Items .......................................................................................................... 136
    When to Order Supplies ................................................................................................................ 137
    Viewing Printer Supply Status ....................................................................................................... 137
    Toner Cartridges ............................................................................................................................ 138
    Recycling Supplies ........................................................................................................................ 139
  Managing the Printer ........................................................................................................................ 140
10 Troubleshooting

General Troubleshooting ......................................................................................................................................... 152
  Printer Does Not Turn On ................................................................................................................................. 152
  Printer Resets or Turns Off Frequently .......................................................................................................... 153
  Printer Does Not Print ...................................................................................................................................... 154
  Printing Takes Too Long ............................................................................................................................... 155
  Document Prints From Wrong Tray .............................................................................................................. 155
  Automatic 2-Sided Printing Problems .......................................................................................................... 156
  Printer Makes Unusual Noises ......................................................................................................................... 156
  Paper Tray Does Not Close ............................................................................................................................. 156
  Condensation Has Formed Inside the Printer ................................................................................................. 156

Paper Jams ......................................................................................................................................................... 157
  Locating Paper Jams ....................................................................................................................................... 157
  Minimizing Paper Jams ................................................................................................................................. 158
  Clearing Paper Jams ...................................................................................................................................... 159
  Troubleshooting Paper Jams ......................................................................................................................... 171
  Print-Quality Problems ............................................................................................................................... 173
  Copy and Scan Problems ............................................................................................................................. 178
  Fax Problems ................................................................................................................................................ 180

Getting Help ..................................................................................................................................................... 182
  Control Panel Messages ............................................................................................................................... 182
  Using the Integrated Troubleshooting Tools ................................................................................................. 183
  Online Support Assistant ............................................................................................................................ 184
  Information Pages ....................................................................................................................................... 184
  More Information ......................................................................................................................................... 184
Contents

A Specifications

Printer Configurations and Options ................................................................. 186
Available Configuration.................................................................................... 186
Standard Features ......................................................................................... 186
Options and Upgrades .................................................................................. 187
Physical Specifications .................................................................................. 188
Weights and Dimensions ............................................................................... 188
Standard Configuration ................................................................................ 188
Configuration Specifications with Optional 550-Sheet Feeder .................. 189
Total Space Requirements ............................................................................ 189
Clearance Requirements ............................................................................... 190
Clearance Requirements with Optional 550-Sheet Feeder ......................... 190
Environmental Specifications ....................................................................... 191
Temperature .................................................................................................. 191
Relative Humidity ......................................................................................... 191
Elevation ....................................................................................................... 191
Electrical Specifications ................................................................................ 192
Power Supply Voltage and Frequency ......................................................... 192
Power Consumption ..................................................................................... 192
ENERGY STAR Qualified Product ............................................................... 192
Performance Specifications .......................................................................... 193
Print Speed ................................................................................................... 193
Controller Specifications ............................................................................... 194
Memory ........................................................................................................ 194
Interfaces ..................................................................................................... 194

B Regulatory Information

Basic Regulations .......................................................................................... 196
United States FCC Regulations ..................................................................... 196
Canada .......................................................................................................... 196
European Union ............................................................................................ 196
European Union Lot 4 Imaging Equipment Agreement Environmental Information ...................................................... 197
Germany ........................................................................................................ 198
Turkey RoHS Regulation ............................................................................... 198
Regulatory Information for 2.4 GHz Wireless Network Adapter .............. 199
Copy Regulations ......................................................................................... 200
United States ............................................................................................... 200
Canada ......................................................................................................... 201
Other Countries .......................................................................................... 202
Fax Regulations ............................................................................................ 203
United States ............................................................................................... 203
Canada ......................................................................................................... 204
European Union .......................................................................................... 205
South Africa ................................................................................................. 205
New Zealand ............................................................................................... 205
## Recycling and Disposal

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material Safety Data Sheets</td>
<td>207</td>
</tr>
<tr>
<td>All Countries</td>
<td>210</td>
</tr>
<tr>
<td>North America</td>
<td>211</td>
</tr>
<tr>
<td>European Union</td>
<td>212</td>
</tr>
<tr>
<td>Domestic/Household Environment</td>
<td>212</td>
</tr>
<tr>
<td>Professional/Business Environment</td>
<td>212</td>
</tr>
<tr>
<td>Collection and Disposal of Equipment and Batteries</td>
<td>213</td>
</tr>
<tr>
<td>Battery Symbol Note</td>
<td>213</td>
</tr>
<tr>
<td>Battery Removal</td>
<td>213</td>
</tr>
<tr>
<td>Other Countries</td>
<td>214</td>
</tr>
</tbody>
</table>
This chapter includes:

- **Electrical Safety** ................................................................. 12
- **Operational Safety** ................................................................. 14
- **Maintenance Safety** ................................................................. 16
- **Printer Symbols** ................................................................. 17
- **Environmental, Health, and Safety Contact Information** ................................................................. 18

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your Xerox printer.
Safety

Electrical Safety

This section includes:

- General Guidelines .......................................................... 12
- Power Cord .................................................................. 12
- Emergency Turn Off ..................................................... 13
- Laser Safety ................................................................. 13

General Guidelines

WARNINGS:

- Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a part could result in fire or electric shock.
- Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Turn off the printer when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- The printer emits smoke, or the surface is unusually hot.
- The printer emits unusual noise or odors.
- The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Power Cord

- Use the power cord supplied with your printer.
- Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

⚠️ **WARNING:** Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

• Only use an extension cord or power strip designed to handle the electrical current capacity of the
printer.
• Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
  Review the electrical specification of the printer with an electrician if necessary.
• Do not place the printer in an area where people can step on the power cord.
• Do not place objects on the power cord.
• Do not plug or unplug the power cord while the power switch is in the On position.
• If the power cord becomes frayed or worn, replace it.
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

**Emergency Turn Off**

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

• The equipment emits unusual odors or makes unusual noises.
• The power cable is damaged or frayed.
• A wall panel circuit breaker, fuse, or other safety device has been tripped.
• Liquid is spilled into the printer.
• The printer is exposed to water.
• Any part of the printer is damaged.

**Laser Safety**

This printer complies with laser product performance standards set by governmental, national, and
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous
light because the beam is totally enclosed during all modes of customer operation and maintenance.

⚠️ **WARNING:** Use of controls, adjustments, or performance of procedures other than those specified in
this manual can result in hazardous radiation exposure.
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

Operational Guidelines

- Do not remove any paper trays while the printer is printing.
- Do not open the doors when the printer is printing.
- Do not move the printer when it is printing.
- Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
- Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the protective covers.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location

- Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the weight for your printer configuration, see Physical Specifications on page 188.
- Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
- Place the printer in an area where there is adequate space for operation and servicing.
- Place the printer in a dust-free area.
- Do not store or operate the printer in an extremely hot, cold, or humid environment.
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
- Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.
- Do not place the printer in locations susceptible to vibrations.
- For optimum performance, use the printer at the elevations specified in Elevation on page 191.
Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
- Store all consumables in accordance with the instructions given on the package or container.
- Keep all consumables away from the reach of children.
- Never throw toner, print/drum cartridges, or toner containers into an open flame.
- When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of skin or eye contact.

⚠️ **CAUTION:** Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Maintenance Safety

- Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with your printer.
- Do not use aerosol cleaners. Clean with a dry lint-free cloth only.
- Do not burn any consumables or routine maintenance items. For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.
# Printer Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Warning Symbol](image) | **Warning:**  
Indicates a hazard which, if not avoided, could result in death or serious injury. |
| ![Caution Symbol](image) | **Caution:**  
Indicates a mandatory action to take in order to avoid damage to the property. |
| ![Hot Surface Symbol](image) | Hot surface on or in the printer. Use caution to avoid personal injury. |
| ![Do Not Burn Symbol](image) | Do not burn the item. |
| ![Do Not Expose Symbol](image) | Do not expose the imaging unit to light for more than 10 minutes. |
| ![Do Not Expose Sunlight Symbol](image) | Do not expose the imaging unit to direct sunlight. |
| ![Do Not Touch Symbol](image) | Do not touch the part or area of the printer. |
| ![Warning Fuser Symbol](image) | **Warning:**  
Wait for the printer to cool for the specified time before touching the fuser. |
| ![Recycling Symbol](image) | This item can be recycled. For details, see Recycling and Disposal on page 209. |

This item can be recycled. For details, see Recycling and Disposal on page 209.
Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact the following customer help lines:

United States: 1-800 828-6571  
Canada: 1-800 828-6571  
Europe: +44 1707 353 434

For product safety information in the United States, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
This chapter includes:

- Parts of the Printer ........................................................................................................................................................... 20
- Energy Saver Mode ......................................................................................................................................................... 25
- Information Pages ........................................................................................................................................................... 26
- Administrative Features ................................................................................................................................................ 27
- More Information ............................................................................................................................................................ 29
Parts of the Printer

This section includes:
- Front View ................................................................. 20
- Rear View ................................................................. 21
- Internal Parts ......................................................... 22
- Control Panel ....................................................... 23

Front View

1. Tray 1
2. Bypass Tray
3. Front Door
4. USB Memory Port
5. Control Panel
6. Duplex Automatic Document Feeder
7. Output Tray
8. Output Tray Paper Stop
9. Front Door Handle
10. Tray 2 (optional)
Rear View

1. Phone Connector
2. Fax Line Connector
3. Wireless Network Adapter Port
4. USB Port
5. Ethernet Connector
6. Rear Door
7. Duplex Unit
8. Transfer Roller
9. Fuser
10. Control Board
11. Power Switch
12. Left Side Door
13. Power Connector
Internal Parts

1. Output Tray Paper Stop
2. Front Door
3. Smart Kit Drum Cartridge
4. Toner Cartridge
5. Duplex Automatic Document Feeder
6. Document Cover
7. Document Glass
Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on the printer. The control panel:

- Displays the current operating status of the printer.
- Provides access to print features.
- Provides access to reference materials.
- Provides access to Tools and Setup menus.
- Provides access to Troubleshooting menus and videos.
- Prompts you to load paper, replace supplies, and clear jams.
- Displays errors and warnings.

1. **Machine Status** button switches the display to the System menus.
2. **Job Status** displays the active jobs, Secure Print Jobs, and Secure Fax Jobs available in Job Status on the touch screen.
3. **Services Home** button invokes the Services home menu for access to printer features, such as copy, scan, and fax.
4. **Touch Screen** displays information and provides access to printer functions.
5. **Alphanumeric Keypad** enters alphanumeric information.
6. **Clear All** clears previous and changed settings for the current selection.
7. **Power Saver** enters and exits low-power mode.
8. **Stop** cancels the current job.
9. **Start** starts the selected copy, scan, fax, or Print From job, such as Print from USB.
10. **Error Indicator**
    - Lights red to indicate an error condition or warning that requires your attention.
    - Blinks red when an error occurs that requires technical support.
11. **Data Indicator**
    - Blinks green when the printer is sending or receiving a fax.
    - Lights green when there is at least one saved job, secure print job, or secure fax job on the device.
Features

12. **Clear** clears a number field or clears the last number of a numeric entry.
13. **Redial/Pause** recalls the last fax number used or inserts pauses in fax numbers.
Energy Saver Mode

You can set the time the printer spends idle in ready mode before the printer transitions to a lower power level.

Exiting Energy Saver Mode

The printer automatically cancels Energy Saver mode when it receives data from a connected computer.

To exit Energy Saver mode manually, press the Power Saver button on the control panel.
Information Pages

Your printer has a printable set of information pages. These include configuration and font information, demonstration pages, and more.

Configuration Report

The Configuration Report lists printer information such as default settings, installed options, network settings including IP address, and font settings. Use the information on this page to help you configure network settings for your printer, and to view page counts and system settings.

Printing a Configuration Report

1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Touch Configuration, then touch Print.
Administrative Features

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. It allows you to configure and administer the printer from a Web browser.

CentreWare Internet Services requires:
- A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
- TCP/IP and HTTP enabled in the printer.
- A network-connected computer with a Web browser that supports JavaScript.

Accessing CentreWare Internet Services

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.

Finding the IP Address of the Printer

You can view the IP address of your printer on the control panel or on the Configuration Report.

Viewing the IP Address at the Control Panel

If Display Network Settings is set to Show IPv4 Address, the address appears in the top left corner of the touch screen display.

Note: To set the IP address to appear on the touch screen, see the System Administrator guide at www.xerox.com/office/WC3615docs.

To view the IP address on the control panel when Display Network Settings is not enabled:
1. At the printer control panel, press the Machine Status button.
2. Touch About this MFP > Network.
3. Record the IP address from the TCP/IP (v4) box in the display.
4. To return to the Services Home menu, press the Services Home button.
Finding the IP Address on the Configuration Report

1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Touch Configuration, then touch Print.

   IPv4 and IPv6 address information is located in the Network Setup section of the Configuration Report under TCP/IPv4 and TCP/IPv6.
# More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Guide</strong></td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Other documentation for your printer</td>
<td><a href="http://www.xerox.com/office/WC3615docs">www.xerox.com/office/WC3615docs</a></td>
</tr>
</tbody>
</table>
| Recommended Media List | United States: www.xerox.com/paper  
European Union: www.xerox.com/europaper |
| Technical support information for your printer; including online technical support, Online Support Assistant, and driver downloads. | www.xerox.com/office/WC3615support |
| Information Pages | Print from the control panel, or from CentreWare Internet Services, click **Status** > **Information Pages**. |
| CentreWare Internet Services documentation | In CentreWare Internet Services, click **Help**. |
| Order supplies for your printer | www.xerox.com/office/WC3615supplies |
| A resource for tools and information, including interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs. | www.xerox.com/office/businessresourcecenter |
| Local sales and support center | www.xerox.com/office/worldcontacts |
| Printer registration | www.xerox.com/office/register |
| Xerox® Direct online store | www.direct.xerox.com/ |
Installation and Setup

This chapter includes:

- Installation and Setup Overview ......................................................... 32
- Selecting a Location for the Printer .................................................. 33
- Connecting the Printer ........................................................................ 34
- Configuring Network Settings ............................................................ 40
- Enabling the Printer for Scanning ..................................................... 41
- Installing the Software ....................................................................... 42
- Installing the Printer as a Web Service on Devices ......................... 47

See also:

Installation Guide packaged with your printer.
Online Support Assistant at www.xerox.com/office/WC3615support
Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure the initial settings of the printer, then install the driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect over a network using an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a USB connection, and it provides access to CentreWare Internet Services.

Note: If the Software and Documentation disc is not available, you can download the latest drivers from www.xerox.com/office/WC3615drivers.

See also:
Selecting a Location for the Printer on page 33
Choosing a Connection Method on page 34
Connecting the Printer on page 34
Configuring Network Settings on page 40
Installing the Software on page 42
Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 15–85 %. 
   Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the weight for your printer configuration, see Physical Specifications on page 188.

After positioning the printer, you are ready to connect it to the power source and computer or network.

See also:
Total Space Requirements on page 189
Clearance Requirements on page 190
Connecting the Printer

This section includes:

- Selecting a Connection Method ................................................................. 34
- Connecting to a Computer Using USB ..................................................... 35
- Connecting to a Wired Network ............................................................... 35
- Finding the IP Address of the Printer ....................................................... 35
- Connecting to a Wireless Network ........................................................... 36
- Connecting to a Telephone Line ............................................................... 39

Selecting a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you select depends on how your computer is connected to the network. A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a network connection, it is important to understand how your computer is connected to the network. For details, see About TCP/IP and IP Addresses on page 40.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately.

- Network: If your computer is connected to an office network or home network, use an Ethernet cable to connect the printer to the network. You cannot connect the printer directly to the computer. It must be connected through a router or hub. An Ethernet network can be used for one or more computers and supports many printers and systems simultaneously. Ethernet connection is typically faster than USB and allows you direct access to the settings of the printer using CentreWare Internet Services.

- Wireless Network: If your computer includes a wireless router or wireless access point, you can connect the printer to the network with a wireless connection. A wireless network connection provides the same access and services as a wired connection provides. A wireless network connection is typically faster than USB and allows direct access to the setting of the printer using CentreWare Internet Services.

- USB: If you connect the printer to one computer and do not have a network, use a USB connection. A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In addition, a USB connection does not provide access to CentreWare Internet Services.

- Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated telephone line.
Connecting to a Computer Using USB

To use USB, you must have Windows XP SP1 and later, Windows Server 2003 and later, or Macintosh OS X version 10.5 and later.

To connect the printer to the computer using a USB cable:
1. Ensure that the printer is turned off.
2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer.
3. Attach the power cord and then plug in the printer and turn it on.
4. Connect the A end of the USB cable to the USB Port on the computer.
5. When the Windows Found New Hardware Wizard appears, cancel it.
6. You are ready to install the print drivers. For details, see Installing the Software on page 42.

Connecting to a Wired Network

1. Ensure that the printer is turned off.
2. Using an Ethernet cable, connect the printer to the network.
3. Attach the power cord to the printer, plug the cord into an electrical outlet, then turn on the printer.
4. Set or automatically discover the network IP address of the printer.

For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs.

Finding the IP Address of the Printer

To install the print drivers for a network-connected printer, you need the IP address of your printer. You also need the IP address to access the settings of your printer through CentreWare Internet Services. You can view the IP address of your printer from the Configuration Report or on the printer control panel.

**Note:** After the printer has been on for two minutes, print the Configuration Report. The TCP/IP address appears in the Network section of the page. If the IP address listed on the page is 0.0.0.0, the printer needs more time to acquire an IP address from the DHCP server. Wait two minutes, then print the Configuration Report again.

To print the Configuration Report:
1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Touch Configuration, then touch Print.

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Admin Settings > Network > Ethernet > TCP/IP.
3. Record the IP address from the display.
4. To return to the Services Home menu, press the Services Home button.
Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN without a physical connection. The printer can connect to a wireless LAN that includes a wireless router or wireless access point. Before connecting the printer to a wireless network, the wireless router must be configured with a service set identifier (SSID), a passphrase, and security protocols.

*Note:* Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

Installing the Wireless Network Adapter

The optional wireless network adapter plugs into the back of the control board. After the adapter is installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless network.

To install the wireless network adapter:

1. Turn off the printer.
2. Remove the packaging from the wireless network adapter.
3. To attach the wireless network adapter to the printer, follow the installation sheet provided with the wireless network adapter.

*Note:* Once the wireless network adapter is installed, remove it only as needed and after reading the instructions for its removal.
4. To enable the wireless network adapter, disconnect the Ethernet cable from the printer.
   
   Note: Only one network connection can be active. During power on, if a network cable is detected, it is enabled and the wireless network adapter is disabled.

5. Turn on the printer.

6. In the Admin Menu, configure the Wi-Fi settings. For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs.
   
   Note: For details on configuring the Wi-Fi settings, refer to the System Administrator Guide.

Removing the Wireless Network Adapter

1. Turn off the printer.

2. Unscrew the thumbscrew on the back of the left door, then open the left door.
3. Locate the plastic latch release on the wireless network adapter that protrudes through the back of the chassis.

4. To remove the wireless network adapter, reach into the chassis and push inward, then back on the latch release.

![Wireless Network Adapter](image)

⚠️ **CAUTION:** Do not use force to pull on the wireless network adapter. If the latch is released properly, the adapter pulls out easily. Pulling on the adapter can damage it.

5. Close the left door, then on the back of the door, screw in the thumbscrew.

6. Connect the printer to your computer with a USB cable or through the network using an Ethernet cable.

7. Turn on the printer.

![Printer](image)

### Resetting Wireless Settings

If the printer was previously installed in a wireless network environment, it could retain setup and configuration information.

To prevent the printer from attempting to connect to the previous network, reset the wireless settings. For details on resetting or connecting to a wireless network, see the *System Administrator Guide* at [www.xerox.com/office/WC3615docs](http://www.xerox.com/office/WC3615docs).
Connecting to a Telephone Line

1. Ensure that the printer is turned off.
2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on the back of the printer.
3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Enable and configure the Fax functions.

For details, see Configuring Fax Settings from the Control Panel.
### Configuring Network Settings

This section includes:
- About TCP/IP and IP Addresses ........................................... 40

#### About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically assigns an IP address to every computer and printer on the network that is configured to use DHCP.

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing.
Enabling the Printer for Scanning

If the printer is connected to a network, you can scan to an FTP address, an email address, or a shared folder on your computer. First you must set up scanning in CentreWare Internet Services. For details, see CentreWare Internet Services on page 27.

If the printer is connected with a USB cable, you can scan to a folder on your computer, or scan into an application. First you must install the scan drivers and the Express Scan Manager utility.

**Note:** If your printer is connected using the USB cable, you cannot scan to an email address or a network location, such as a shared folder on your computer.

For details, see the *System Administrator Guide* at www.xerox.com/office/WC3615docs.
Installing the Software

This section includes:

- Operating System Requirements ............................................................................................................................... 42
- Installing the Print Drivers for a Windows Network Printer ............................................................................. 42
- Installing the Print Drivers for a Windows USB Printer ...................................................................................... 43
- Installing Print Drivers for Macintosh OS X Version 10.5 and Later ............................................................. 44
- Installing Scan Drivers for Macintosh ...................................................................................................................... 45
- Installing Drivers and Utilities for UNIX and Linux ............................................................................................. 45
- Other Drivers .......................................................................................................................................................... 46

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If you cannot find the IP address, see Finding the IP Address of Your Printer on page 27.

If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/office/WC3615drivers.

Operating System Requirements

- Macintosh OS X version 10.5, 10.6, 10.7, and 10.8.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface. For details, see www.xerox.com/office/WC3615drivers.

Installing the Print Drivers for a Windows Network Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
   If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
2. Click Network Installation.
3. At the bottom of the Driver Installation window, click Language.
4. Select your language, then click OK.
5. Click Next.
6. To accept the agreement, click I accept the terms, then click Next.
7. In the Discovered Printers list, select your printer, then click Next.
   Note: When installing drivers for a network printer, if you do not see your printer in the list, click the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your printer, then click Search to locate your printer. If you do not know the IP address of the printer, see Finding the IP Address of Your Printer on page 35.
8. To start the installation, click Next.
9. When the installation is complete, at the Enter Printer Settings screen, select the following as needed:
   – Share this printer with other computers on the network
   – Set this printer as default for printing
10. Click Next.
11. In the Software and Documentation window, for any option you do not want to install, clear the check box.
12. Click Install.
13. At the InstallShield Wizard, click Yes to restart your computer, then click Finish.
14. At the Product Registration screen, select your country from the list, then click Next. Complete the registration form, then submit it.

Installing the Print Drivers for a Windows USB Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
2. At the bottom of the Driver Installation window, click Language.
3. Select your language, then click OK.
4. Select the printer model, then click Install Print and Scan Drivers.
5. To accept the agreement, click I Agree, then click Next.
6. At the Product Registration screen, from the list, select your country, then click Next.
7. Complete the registration form, then click Submit.
   Notes: The following applications are installed on your computer with the print driver:
   • Express Scan Manager
   • Address Book Editor

See also:
Online Support Assistant at: www.xerox.com/office/WC3615support
Installing Print Drivers for Macintosh OS X Version 10.5 and Later

Install the Xerox print driver to access all features of your printer.

To install the print driver software:
1. Insert the *Software and Documentation disc* into the appropriate drive on your computer.
2. To view the *dmg* file for your printer, double-click the disc icon on your desktop.
3. Open the *dmg* file, then navigate to the appropriate installer file for your operating system.
4. Open the installer file.
5. To acknowledge the warning and introductory messages, click *Continue*. Click *Continue* again.
6. To accept the license agreement, click *Continue*, then click *Agree*.
7. To accept the current installation location, click *Install*, or select another location for the installation files, then click *Install*.
8. Enter your password, then click *OK*.
9. Select your printer in the list of discovered printers, then click *Continue*.
10. If your printer does not appear in the list of discovered printers:
    a. Click the *Network Printer Icon*.
    b. Type the IP address of your printer, then click *Continue*.
    c. Select your printer in the list of discovered printers, then click *Continue*.
11. To accept the print queue message, click *OK*.
12. To accept the installation success message, click *Close*.

    *Note:* The printer is automatically added to the printer queue in Macintosh OS X version 10.4 and later.

To verify that the print driver recognizes the installed options:
1. From the Apple menu, click *System Preferences* > *Print and Scan*.
2. Select the printer in the list, then click *Options and Supplies*.
3. Click *Driver*, then confirm that your printer is selected.
4. Confirm that all of the options installed on the printer appear correct.
5. If you change settings, click *OK*, close the window, then exit System Preferences.
Installing Scan Drivers for Macintosh

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. To view the .dmg file for your printer, double-click the disc icon on your desktop.
3. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating system.
4. Open the Scan Installer package file.
5. To acknowledge the warning and introductory messages, click Continue.
6. To accept the license agreement, click Continue, then click Agree.
7. Click Continue again.
8. Enter your password, then click OK.
9. If prompted to close other installations, click Continue Installing.
10. To restart, click Log Out.

Installing Drivers and Utilities for UNIX and Linux

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a Xerox® Services for UNIX Systems code package and a printer support package. The Xerox® Services for UNIX Systems code package must be installed before installing the printer support package.

Note: You must have root or superuser privileges to perform the UNIX print driver installation on your computer.

1. At the printer, do the following:
   a. Verify that both the TCP/IP protocol and the proper connector are enabled.
   b. On the printer control panel, do one of the following for the IP address:
      i. Allow the printer to set up a DHCP address.
      ii. Enter the IP address manually.
2. At your computer, do the following:
   a. Go to www.xerox.com/office/WC3615drivers and select your printer model.
   b. From the Operating System menu, select UNIX, then click Go.
   c. Select the Xerox® Services for UNIX Systems package for the correct operating system. This package is the core package and must be installed before the printer support package.
   d. To begin downloading, click the Start button.
   e. Repeat steps a and b, then click the printer package for use with the Xerox® Services for UNIX Systems package that you selected earlier. The second part of the driver package is ready for download.
   f. To begin downloading, click the Start button.
   g. In the notes below the driver package that you selected, click the link for the Installation Guide, then follow the installation instructions.

Notes:

- To load Linux print drivers, perform the preceding procedures but select Linux as the operating system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. You can also use the CUPS driver included in the Linux package.
- Supported Linux drivers are available at www.xerox.com/office/WC3615drivers.
- For details about UNIX and Linux drivers, see the System Administrator Guide at www.xerox.com/office/WC3615docs.

Other Drivers

The following drivers are available for download at www.xerox.com/office/WC3615drivers.

- The Xerox® Global Print Driver works with any printer on your network, including those printers made by other manufacturers. It configures itself for your individual printer upon installation.
- The Xerox® Mobile Express Driver works with any printer available to your computer that supports standard PostScript. It configures itself for the printer you select every time you print. If you travel frequently to the same sites, you can save your favorite printers in that location and the driver saves your settings.
Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated services across a network. WSD supports device discovery, control, and use.

To install a WSD printer using the Add Device Wizard:
1. At your computer, click **Start**, then select **Devices and Printers**.
2. To launch the Add Device Wizard, click **Add a Device**.
3. In the list of available devices, select the one you want to use, then click **Next**.
   
   **Note:** If the printer you want to use does not appear in the list, click the **Cancel** button. Add the WSD printer manually using the Add Printer Wizard.
4. Click **Close**.

To install a WSD printer using the Add Printer Wizard:
1. At your computer, click **Start**, then select **Devices and Printers**.
2. To launch the Add Printer Wizard, click **Add a Printer**.
3. Click **Add a network, wireless, or Bluetooth printer**.
4. In the list of available devices, select the one you want to use, then click **Next**.
5. If the printer you want to use does not appear in the list, click **The printer that I want is not listed**.
6. Select **Add a printer using a TCP/IP address or hostname**, then click **Next**.
7. From the Device type field, select **Web Services Device**.
8. Enter the printer IP address in the Hostname or IP address field, then click **Next**.
9. Click **Close**.
This chapter includes:

- Supported Paper ............................................................................................................................................................... 50
- Loading Paper ................................................................................................................................................................... 54
- Loading Paper in the Bypass Tray ............................................................................................................................. 65
- Printing on Special Paper .............................................................................................................................................. 68
Supported Paper

This section includes:

- Recommended Media .................................................................................................................................................... 50
- Ordering Paper .................................................................................................................................................................. 50
- General Paper Loading Guidelines ............................................................................................................................ 50
- Paper That Can Damage Your Printer ...................................................................................................................... 51
- Paper Storage Guidelines .............................................................................................................................................. 51
- Supported Paper Types and Weights ....................................................................................................................... 52
- Supported Standard Paper Sizes ................................................................................................................................ 52
- Supported Paper Types and Weights for Automatic 2-Sided Printing ................................................................ 53
- Supported Standard Paper Sizes for Automatic 2-Sided Printing ................................................................ . 53
- Supported Custom Paper Sizes ................................................................................................................................ 53

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:
- www.xerox.com/paper Recommended Media List (United States)
- www.xerox.com/europaper Recommended Media List (Europe)

Ordering Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC3615supplies.

General Paper Loading Guidelines

- Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
- Adjust the paper guides to fit the paper size.
- Fan paper before loading it in the paper tray.
- If excessive jams occur, use paper or other approved media from a new package.
- Do not print on label media once a label has been removed from a sheet.
- Use only paper envelopes. Print envelopes 1-sided only.
Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media

⚠️ CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.
- Reduce the exposure of paper to strong lights for long periods of time.
- Maintain constant temperatures and relative humidity.
- Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
- Store paper flat, either on pallets, cartons, shelves, or in cabinets.
- Avoid food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain.
- Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are ready to use it. Keep unused media in the bag and reseal it for protection.
## Supported Paper Types and Weights

<table>
<thead>
<tr>
<th>Trays</th>
<th>Paper Types</th>
<th>Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Trays</td>
<td>Plain</td>
<td>(60–80 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hole Punched</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rough Surface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Colored</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Plain Thick</td>
<td>(81–105 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hole Punched</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Colored</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Light Card</td>
<td>(106–163 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Heavy Card</td>
<td>(164–216 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Labels</td>
<td></td>
</tr>
<tr>
<td>Bypass Tray only</td>
<td>Envelope</td>
<td></td>
</tr>
</tbody>
</table>

## Supported Standard Paper Sizes

<table>
<thead>
<tr>
<th>Tray</th>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Trays</td>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td></td>
<td>B5 (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Oficio (216 x 343 mm, 8.5 x 13.5 in.)</td>
</tr>
<tr>
<td></td>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.)</td>
<td>Folio (216 x 330 mm, 8.5 x 13 in.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.)</td>
</tr>
<tr>
<td>Bypass Tray</td>
<td>C5 envelope (162 x 229 mm, 6.4 x 9 in.)</td>
<td>Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.)</td>
</tr>
<tr>
<td></td>
<td>DL envelope (110 x 220 mm, 4.33 x 8.66 in.)</td>
<td>No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)</td>
</tr>
</tbody>
</table>
Supported Paper Types and Weights for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Paper Types</th>
<th>Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>(60–80 g/m²)</td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Hole Punched</td>
<td></td>
</tr>
<tr>
<td>Colored</td>
<td></td>
</tr>
<tr>
<td>Plain Thick</td>
<td>(81–105 g/m²)</td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Hole Punched</td>
<td></td>
</tr>
<tr>
<td>Colored</td>
<td></td>
</tr>
<tr>
<td>Light Card</td>
<td>(106–163 g/m²)</td>
</tr>
</tbody>
</table>

Supported Standard Paper Sizes for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td>B5 (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Oficio (216 x 343 mm, 8.5 x 13.5 in.)</td>
</tr>
<tr>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.)</td>
<td>Folio (216 x 330 mm, 8.5 x 13 in.)</td>
</tr>
<tr>
<td></td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.)</td>
</tr>
</tbody>
</table>

Supported Custom Paper Sizes

Bypass Tray
- Width: 76.2–215.9 mm (3–8.5 in.)
- Length: 127–355.6 mm (5–14 in.)

Tray 1
- Width: 76.2–215.9 mm (3–8.5 in.)
- Length: 127–355.6 mm (5–14 in.)

Trays 2–4
- Width: 139.7–215.9 mm (5.5–8.5 in.)
- Length: 210–355.6 mm (8.3–14 in.)
Loading Paper

This section includes:
• Loading Paper in the Bypass Tray .............................................................. 54
• Loading Small Paper Sizes in the Bypass Tray ............................................. 57
• Configuring Trays 1–4 for the Paper Length .................................................. 59
• Loading Paper in Trays 1–4 ........................................................................ 61
• Configuring Tray Behavior ......................................................................... 63

Loading Paper in the Bypass Tray

1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a different size or type.

2. Move the width guides to the edges of the tray.
3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

   ![Image of sheets being flexed and fanned]

   **Note:** To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.

4. Load the paper in the tray. Load hole punched paper with the holes to the left.

   - For 1-sided printing, load letterhead or pre-printed face up with the top edge going into the printer.

   **Note:** Letterhead Duplex Mode allows 1-sided print jobs to be loaded in the same orientation as 2-sided print jobs. For details, see Enabling Letterhead Duplex Mode on page 82.
– For 2-sided printing, load letterhead and pre-printed face down with the top edge facing you.

**Note:** Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

5. Adjust the width guides until they touch the edges of the paper.

6. If the control panel prompts you, on the screen, verify the paper size and type.

7. To specify the settings on the printer control panel, for Use Driver Settings for Print Job, clear the check box.
   a. Touch **Size**, then, for a standard paper size, touch an option.
   b. Touch **Type**, then, for the paper type, touch an option.
   c. Touch **OK**.

8. Verify or set the paper size and type.
   a. At the printer control panel, press the **Machine Status** button.
   b. Touch **Tools > Tray Management > Tray Settings**.
   c. Touch the desired tray.

**Note:** When you select the bypass tray, the check box for Use Driver Settings for Print Job is set by default. To change the setting, clear the check box.

d. Touch **Size**, then touch an option as needed.
e. Touch **Type**, then touch an option as needed.
Loading Small Paper Sizes in the Bypass Tray

To simplify loading paper in the bypass tray, remove the tray from the printer.

1. Open the bypass tray.

2. To remove the bypass tray from the printer, pull the tray straight out of the printer.

3. If the bypass tray is loaded with paper already, remove any paper that is a different size or type. Then, raise the paper stop.
4. Move the width guides to the edges of the tray.

5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

   **Note:** To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.

6. Load the paper in the tray.

   **Note:** Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

7. Adjust the width guides until they touch the edges of the paper.
8. Adjust the paper stop until it touches the edges of the paper.

9. Slide the tray back into the printer.

10. If the control panel prompts you, on the screen, verify the paper size and type.
11. To specify the settings on the printer control panel, for Use Driver Settings for Print Job, clear the check box.
   a. Touch Size, then, for a standard paper size, touch an option.
   b. Touch Type, then, for the paper type, touch an option.
   c. Touch OK.
12. Verify or set the paper size and type.
   a. At the printer control panel, press the Machine Status button.
   b. Touch Tools > Tray Management > Tray Settings.
   c. Touch the desired tray.
   
   Note: When you select the bypass tray, the check box for Use Driver Settings for Print Job is set by default. To change the setting, clear the check box.
   d. Touch Size, then touch an option as needed.
   e. Touch Type, then touch an option as needed.

For instructions on setting tray prompts, see Configuring Tray Behavior.

**Configuring Trays 1–4 for the Paper Length**

You can adjust the lengths of trays 1 and 2 to accommodate A4/Letter and Legal paper sizes. In the Legal length settings, the trays protrude from the front of the printer.

To change the 550-Sheet Feeders in trays 1–4 to match the paper length:
1. Remove all paper from the tray.
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.

![Image of removing the tray](image1)

3. To extend the tray, with one hand, hold the back of the tray. With the other hand, at the front of the tray, press the release latch and pull the ends outward until they latch.

![Image of extending the tray](image2)

4. To protect the paper, place the paper cover over the extended section of the paper tray.

![Image of placing paper cover](image3)

5. To compress the tray for shorter paper, with one hand, hold the back of the tray. With the other hand, at the front of the tray, press the release latch, then push the ends inward until they latch.

6. Load paper into the tray, then insert it back into the printer. For details, see Loading Paper in Trays 1–4 on page 61.

![Image of loading paper](image4)
Loading Paper in Trays 1–4

1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.

2. At the back of the paper tray, press the paper lift tray down until it locks.
3. Adjust the paper length and width guides as illustrated.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

5. Load paper into the tray with the print side face up.
   − Load hole punched paper with the holes to the left.
   − For 1-sided printing, load letterhead face up with the top of the paper toward the back of the tray.
   − For 2-sided printing, load letterhead and pre-printed face down with the top edge facing you.
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

6. Adjust the length and width guides to fit the paper.

7. Slide the tray back into the printer.

8. Push the tray in all the way.

Notes:
- If the tray does not go in all the way, ensure that the paper lift plate at the back of the tray is locked down.
- If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.

9. If the control panel prompts you, on the screen, verify the paper size and type.

10. To specify the settings on the printer control panel, for Use Driver Settings for Print Job, clear the check box.
   a. Touch Size, then, for a standard paper size, touch an option.
   b. Touch Type, then, for the paper type, touch an option.
   c. Touch OK.
11. Verify or set the paper size and type.
   a. At the printer control panel, press the Machine Status button.
   b. Touch Tools > Tray Management > Tray Settings.
   c. Touch the desired tray.
      
      Note: When you select the bypass tray, the check box for Use Driver Settings for Print Job is set by default. To change the setting, clear the check box.
   d. Touch Size, then touch an option as needed.
   e. Touch Type, then touch an option as needed.

Configuring Tray Behavior

When an individual tray is set to Display Tray Prompt mode, the control panel prompts you to verify or set the paper size and type.

The Tray Priority feature determines the order in which the printer selects the tray for a print job when you have not specified one. Tray Priority also determines how the printer selects another tray when a paper tray runs out in the middle of a job. Priority 1 indicates that the tray is set to the highest priority.

Tray Mode allows you to have the control panel or the print driver specify the bypass tray mode.

To set the Display Tray Prompt mode:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Tray Management > Tray Settings.
3. Touch the desired tray.
4. Select the Display Tray Prompt check box.
5. Touch OK.

To set the priority for a tray:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Tray Management > Tray Priority.
3. To specify the first priority, touch 1-First.
4. On the 1-First screen, touch the desired tray, then touch OK.
5. To establish priority for any remaining trays, repeat the steps.

Note: As each priority is assigned to a tray, the menu advances to the next priority automatically. When there are no trays left to prioritize, the menu returns to Tray Priority.
To set the Tray Mode:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Tray Management > Tray Settings.
3. Touch Bypass Tray.
   - To specify the settings in the print driver, for Use Driver Settings for Print Job, select the check box.
   - To specify the settings on the printer control panel, for Use Driver Settings for Print Job, clear the check box.
4. Touch OK.
Loading Paper in the Bypass Tray

1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a different size or type.

2. Move the width guides to the edges of the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

**Note:** To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.
4. Load the paper in the tray. Load hole punched paper with the holes to the left.

- For 1-sided printing, load letterhead or pre-printed face up with the top edge going into the printer.

  **Note:** Letterhead Duplex Mode allows 1-sided print jobs to be loaded in the same orientation as 2-sided print jobs. For details, see [Enabling Letterhead Duplex Mode](#) on page 82.

- For 2-sided printing, load letterhead and pre-printed face down with the top edge facing you.

  **Note:** Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
5. Adjust the width guides until they touch the edges of the paper.

6. If the control panel prompts you, on the screen, verify the paper size and type.

7. To specify the settings on the printer control panel, for Use Driver Settings for Print Job, clear the check box.
   a. Touch Size, then, for a standard paper size, touch an option.
   b. Touch Type, then, for the paper type, touch an option.
   c. Touch OK.

8. Verify or set the paper size and type.
   a. At the printer control panel, press the Machine Status button.
   b. Touch Tools > Tray Management > Tray Settings.
   c. Touch the desired tray.
   
   Note: When you select the bypass tray, the check box for Use Driver Settings for Print Job is set by default. To change the setting, clear the check box.
   d. Touch Size, then touch an option as needed.
   e. Touch Type, then touch an option as needed.
Printing on Special Paper

This section includes:

- Envelopes ............................................................................................................................................................................ 68
- Labels .................................................................................................................................................................................... 72
- Glossy Cardstock .............................................................................................................................................................. 73

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC3615supplies.

See also:
www.xerox.com/paper Recommended Media List (United States)
www.xerox.com/europaper Recommended Media List (Europe)

Envelopes

You can print envelopes from the bypass tray only.

Guidelines for Printing Envelopes

- Print quality depends on the quality and construction of the envelopes. Try another envelope brand if you do not get desired results.
- Maintain constant temperatures and relative humidity.
- Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.
- Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of them.
- In the print driver software, select Envelope as the paper type.
- Do not use padded envelopes. Use envelopes that lie flat on a surface.
- Do not use envelopes with heat activated glue.
- Do not use envelopes with press and seal flaps.
- Use only paper envelopes.
- Do not use envelopes with windows or metal clasps.
Loading Envelopes in the Bypass Tray

1. Open the bypass tray.

2. Move the width guides to the edges of the tray.

**Note:** If you do not load envelopes in the bypass tray right after they have been removed from the packaging, they can bulge. Flatten them to avoid jams.
3. To load envelopes, select an option:
   - For Number 10 envelopes, load the envelopes with the short edge going into the printer, flaps down, and flaps to the right.

   ![Diagram of Number 10 envelope loading](image)

   - For C5 envelopes, do one of the following.
     - Insert envelopes with the print side up, flaps open and down, and the bottom of the envelope going into the printer.

     ![Diagram of C5 envelope loading](image)

     - Insert envelopes with the print side up, flaps closed and down, and flaps going into the printer.

   - For Monarch or DL envelopes do one of the following.
Note: Remove the Multipurpose Tray when loading Monarch or DL envelopes. For details, see Loading Small Paper Sizes in the Bypass Tray on page 57.

- Insert envelopes with the short edge going into the printer, flaps down, and flaps to the right.

- Insert envelopes with the print side up, flaps open and down, and the bottom of the envelope going into the printer.

- Insert envelopes with the print side up, flaps closed and down, and flaps going into the printer.

Note: To have envelopes print correctly, when you load envelopes with the flaps open, in the print driver, select Portrait, Landscape, or Rotated Landscape, as needed. To flip the image, in the print driver, use Rotate Image 180 Degrees, as needed.
4. At the printer control panel, press the **Machine Status** button.
5. Touch **Tools > Tray Management > Tray Settings**.
6. Touch **Bypass Tray**.
7. For Use Driver Settings for Print Job, clear the check box.
8. Touch **Size**, then select an option.
9. Touch **Type**, then touch **Envelope**.
10. Touch **OK**.

### Labels

You can print labels from any tray.

#### Guidelines for Printing Labels

- Use labels designed for laser printing.
- Do not use vinyl labels.
- Do not feed a sheet of labels through the printer more than once.
- Do not use dry gum labels.
- Print only on one side of the sheet of labels. Use full sheet labels only.
- Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal it.
- Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in extreme conditions can cause print-quality problems or cause them to jam in the printer.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.
- In the print driver software, select Label as the paper type.
- Remove all other paper from the tray before loading labels.

⚠️ **CAUTION:** Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could damage the printer.

#### Loading Labels in the Bypass Tray

1. Remove all paper from the tray.
2. Load labels face up with the top of the page going into the printer.
3. Adjust the width guides until they touch the edges of the paper.
4. On the control panel, change the type to **Label**.
5. On the control panel, select the size.
6. Touch **OK**.
7. In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type setting.
Glossy Cardstock

You can print Lightweight Glossy Cardstock and Heavyweight Glossy Cardstock up to 216 g/m² from any tray.

Guidelines for Printing on Glossy Cardstock

- Do not open sealed packages of glossy cardstock until you are ready to load them into the printer.
- Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until ready to use.
- Remove all other paper from the tray before loading glossy cardstock.
- Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to curl and jam in the printer.
- In the print driver software, select the desired glossy cardstock type or select the tray loaded with the desired paper.
This chapter includes:

- Printing Overview ................................................................. 76
- Selecting Printing Options .................................................. 77
- Printing Features ................................................................. 80
- Using Custom Paper Sizes ..................................................... 88
Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure that you have the correct print driver software installed on your computer. For details, see Installing the Software on page 42.

1. Select the appropriate paper.
2. Load paper in the appropriate tray.
3. At the printer control panel, specify the size and type.
4. In your software application, access the print settings. For most software applications, press CTRL+P for Windows or CMD+P for Macintosh.
5. Select your printer from the list.
6. To access the print driver settings for Windows, select Properties or Preferences. For Macintosh select Xerox® Features.
   
   Note: The title of the button varies depending on your application.

7. Modify the print driver settings as needed, then click OK.
8. Click Print to send the job to the printer.
Selecting Printing Options

This section includes:

- Print Driver Help................................................................................................................................................................ 77
- Windows Printing Options ............................................................................................................................................ 77
- Macintosh Printing Options ......................................................................................................................................... 79

Printing options, also called print driver software options, are specified as Printing Preferences in Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality. Printing options that are set from Printing Preferences become the default setting. Printing options that are set from within the software application are temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.

Information about Printing Preferences appears in the Help window. From there, you can select by topic or use the search field to enter the topic or function for which you need information.

Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the Printing Preferences window. You can specify your most common printing options and save them so that you do not have to change them every time you print.
For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing Preferences.

To select default printing options:

1. Navigate to the list of printers on your computer:
   - For Windows XP SP2 and later, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows Server 2003 and later, click Start > Settings > Printers.
   - For Windows 7, click Start > Devices and Printers.
   - For Windows 8, click Control Panel > Devices and Printers.
   
   Note: If the Control Panel icon does not display on the desktop, right-click on the desktop, then, select Personalize > Control Panel Home > Devices and Printers.

2. In the list, right-click the icon for your printer and click Printing Preferences.
3. In the Printing Preferences window, click a tab, select the options, then click OK to save.

   Note: For more information about Windows print driver options, click the Help button (?) in the Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, change the Printing Preferences from the application before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode when printing a particular document, select Enhanced in Printing Preferences before printing the job.

1. With the document open in your software application, access the print settings. For most software applications, click File > Print or press CTRL+P for Windows.
2. Select your printer and click the Properties or Preferences button to open the Printing Preferences window. The title of the button can vary depending on your application.
3. Click a tab in the Printing Preferences window, then make selections.
4. Click OK to save and close the Printing Preferences window.
5. Click Print to send the job to the printer.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File > Print.
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences.
3. In the Printing Properties window, click the tabs, then select the desired settings
4. At the bottom of the Printing Properties window, click Saved Settings, then click Save As.
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, then click OK.
6. To print using these options, select the name from the list.
Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.

1. With the document open in your application, click **File > Print**.
2. Select your printer from the list.
3. Select **Xerox® Features** from the Copies & Pages menu.
4. Select the desired printing options from the drop-down lists.
5. Click **Print** to send the job to the printer.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click **File > Print**.
2. Select your printer from the Printers list.
3. Select the desired printing options from the drop-down lists in the Print dialog box.
4. Click **Presets > Save As**.
5. Type a name for the printing options, then click **OK** to save the set of options in the Presets list.
6. To print using these options, select the name from the Presets list.
Printing Features

This section includes:

- Printing on Both Sides of the Paper ................................................................. 80
- Orientation ........................................................................................................ 81
- Selecting Paper Options for Printing ............................................................ 82
- Enabling Letterhead 2-Sided Mode ............................................................... 82
- Printing Multiple Pages to a Single Sheet ..................................................... 83
- Printing Booklets ............................................................................................ 83
- Print Quality ..................................................................................................... 84
- Lightness .......................................................................................................... 84
- Printing Watermarks ...................................................................................... 84
- Scaling ............................................................................................................. 85
- Printing Mirror Images .................................................................................... 85
- Printing from a USB Flash Drive ................................................................. 85
- Printing Special Job Types ............................................................................. 86

Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses the settings for portrait or landscape orientation from the application for printing the document.

Note: Ensure that the paper size and weight are supported. For details, see Supported Paper Sizes and Weights for Automatic 2-Sided Printing on page 53.

Setting Up 1-Sided Printing

To set 1-sided printing as the default setting:

1. Navigate to the list of printers on your computer.
2. From the Printers and Faxes window, select a printer, right-click the printer, then select Printing preferences.
3. On the Printing Options tab, click the arrow to the right of the 2-Sided Printing, then select 1-Sided Print.
4. To close the Printing Preferences dialog box, click OK.
2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings override the application page orientation settings.

To make a 2-sided printing selection, on the Page Layout tab, in the bottom left corner of the preview pane, use the arrow button. Page Layout is located on the Document Options tab.

- **1-Sided Print** prints on one side of the media. Use this option when printing on transparencies, envelopes, labels, or other media that cannot be printed on both sides.

- **2-Sided Print** prints the job on both sides of the paper to allow binding on the long edge of the paper. The following illustrations show the result for documents with portrait and landscape orientations, respectively:

- **2-Sided Print, Flip on Short Edge** prints on both sides of the paper. The images print to allow binding on the short edge of the paper. The following illustrations show the result for documents with portrait and landscape orientations, respectively:

  ![Illustration](image)

  ![Illustration](image)

  **Note:** 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, see Setting Default Printing Options for Windows.

Orientation

To select the default orientation:
1. In the print driver, on the Document Options tab, click the Orientation tab.
2. Select an option:
   - **Portrait** orients the paper so that the text and images print across the short dimension of the paper.
   - **Landscape** orients the paper so that the text and images print across the long dimension of the paper.
   - **Rotated Landscape** orients the paper so that the content is rotated 180 degrees and with the long bottom side up.
3. Click OK.

**Selecting Paper Options for Printing**

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on the document size and paper type that you specify. You can also select a specific tray loaded with the desired paper.

**Enabling Letterhead 2-Sided Mode**

Letterhead Duplex Mode allows you to load 1-sided print jobs in the same orientation as 2-sided print jobs. Enabling this feature allows you to print 1-sided or 2-sided print jobs from the same tray without switching paper orientation.

To enable Letterhead Duplex Mode:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol (+).
4. From the General Setup menu, click System Settings.
5. Under Output Settings, next to Letterhead Duplex Mode, click Enable.
6. Click Save Changes.
Printing Multiple Pages to a Single Sheet

When printing a multiple-page document, you can print more than one page on a single sheet of paper. Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout is on the Document Options tab.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any paper size that is supported for 2-sided printing. The driver automatically reduces each page image and prints four page images per sheet of paper, two page images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create the booklet.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.

- **Gutter** specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).
- **Creep** specifies how much the page images are shifted outward, in tenths of a point. Shifting compensates for the thickness of the folded paper, which would cause the page images to shift slightly outward when folded. You can select a value from zero to 1 point.
Print Quality

Print quality modes:
- Standard print-quality mode: 600 x 600 dpi
- Enhanced print-quality mode: 1200 x 1200 dpi

Lightness

Lightness allows you to adjust the overall lightness or darkness of the text and images in your printed job.
1. To adjust the lightness, on the Image Options tab, move the slider to the right to lighten or to the left to darken your print job.
2. Click OK or Apply.

Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

To print a watermark:
1. In the print driver, click the Document Options tab.
2. Click the Watermarks tab.
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a customized watermark. You can also manage watermarks from this menu.
4. Under Text, select an option:
   - Text: Enter the text in the field, then specify the font.
   - Time Stamp: Specify the date and time options, then specify the font.
   - Picture: To locate the picture, click the Browse icon.
5. Specify the scaling angle and position of the watermark.
   - Select the scaling option that specifies the size of the picture in relation to the original image. Use the arrows to scale the image in increments of 1%.
   - To define the angle of the image on the page, specify the position option or to rotate the image left or right by increments of 1, use the arrows.
   - To define the location of the image on the page, specify the position option, or to move the image in each direction in increments of 1, use the arrows.
6. Under Layering, select how to print the watermark.
   - Print in Background prints the watermark behind the text and graphics in the document.
   - Blend combines the watermark with the text and graphics in the document. A blended watermark is translucent, so you can see both the watermark and the document content.
   - Print in Foreground prints the watermark over the text and graphics in the document.
7. Click **Pages**, then select the pages to print the watermark:
   − **Print on All Pages** prints the watermark on all pages of your document.
   − **Print on Page 1 Only** prints the watermark only on the first page of the document.

8. If you select a picture as a watermark, specify the lightness settings for the image.

9. Click **OK**.

**Scaling**

Scaling reduces or enlarges the original document to match the selected output paper size. In Windows, the Scale Options are located in the print driver on the Printing Options tab in the Paper field.

To access Scaling Options, to the right of the Paper field, click the arrow, then select **Other Size -> Advanced Paper Size**.

- **Automatically Scale** scales the document to fit the selected Output Paper Size. The scaling amount appears in the percentage box below the sample image.
- **No Scaling** does not change the size of the page image printed on the output paper, and 100% appears in the percentage box. If the original size is larger than the output size, the page image is cropped. If the original size is smaller than the output size, extra space appears around the page image.
- **Manually Scale** scales the document by the amount entered in the percentage box below the preview image.

**Printing Mirror Images**

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.

**Printing from a USB Flash Drive**

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.

To print from a USB Flash drive:

1. Insert the USB Flash Drive into the USB memory port on the printer.
2. At the USB Drive Detected screen, select **Print from USB**.
3. Browse to a file, then touch the file name or icon.
4. Touch **OK**.
5. For Paper Supply, 2-Sided Printing, Sides Per Page, and PDF Password, select an option. If you select PDF Password, enter the PDF password, then touch **OK**.
6. To enter the number of copies to print, use the keypad.
7. Press the green **Start** button.
8. To print another file from the USB Flash drive, select a file and repeat the steps.
9. When finished, remove the USB Flash drive.

To print from a USB Flash drive that is inserted in the printer:
1. If the USB Flash drive is already inserted into the USB memory port, touch Print From > USB Memory.
2. Browse to a file, then touch the file name or icon.
3. Touch OK.
4. For Paper Supply, 2-Sided Printing, Sides Per Page, and PDF Password, select an option.
5. To enter the number of copies to print, use the keypad.
6. Press the green Start button.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Note: Special job types stored on the RAM disk on the printer are removed when the printer powers off. To store the special job types permanently, install the Device Memory option on the printer.

Saved Job

Saved jobs are documents sent to the printer and stored there for future use. Saved jobs appear in the Print From menu in Services Home.

Note: If you select a picture as a watermark, specify the lightness settings for the image.

To print a saved job:
1. If the control panel is dark, press the Power Saver button.
2. Touch the Print From service, then touch Saved Jobs.
3. Touch the user name or name of the folder that contains the saved job.
4. Touch the name of the saved job, touch Quantity, select the number of copies to print, then touch OK.
5. Touch Print.
6. To delete the document after printing, select Delete after printing.
7. Touch OK.
Secure Print

Secure Print allows you to associate a 1–12 digit passcode number with a print job when sending it to the printer. The job is held at the printer until the same passcode is entered at the control panel.

To release a Secure Print job for printing:
1. If the control panel is dark, press the Power Saver button.
2. At the printer control panel, press the Job Status button.
3. Touch Secure Jobs, then touch the user name or folder name for the secure job.
4. Enter the passcode number that you assigned to the print job using the keypad.
5. Touch OK.
6. Touch the name of the desired print job.
7. Touch Quantity, enter the number of copies to print, then touch OK.
8. Touch Print and Delete.
9. Touch OK.
Using Custom Paper Sizes

This section includes:
- Defining Custom Paper Sizes .......................................................................................................................... 88
- Creating and Saving Custom Paper Sizes ........................................................................................................ 88
- Printing on Custom Paper Sizes .................................................................................................................... 89

The Xerox® WorkCentre® 3615 Black and White Multifunction Printer prints on custom paper sizes that are within the minimum and maximum size range supported by the printer. For details, see Supported Standard Paper Sizes on page 52 and Supported Custom Paper Sizes on page 53.

Defining Custom Paper Sizes

To print custom paper sizes, define the custom width and length of the paper in the print driver software and on the printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override control panel settings when you print using the print driver software on your computer.

Creating and Saving Custom Paper Sizes

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print driver and are available for you to select in all your applications.

For detail on supported paper sizes for each tray, see Supported Custom Paper Sizes on page 53.

To create and save custom sizes for Windows:
1. Click the Printing Options tab of the print driver.
2. Click the arrow next to the Paper field, then select Other Size > Output Paper Size > New.
3. In the New Custom Paper Size window, enter the height and width of the new size.
4. At the bottom of the New Custom Paper Size window, click Units.
5. Click Inches or Millimeters.
6. To save, in the Name field, type a title for the new size, then click OK.
7. Click OK.
To create and save custom sizes for Macintosh:
1. In the application, click **File > Page Setup**.
2. Click **Paper Sizes**, then select **Manage Paper Sizes**.
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+).
4. Double-click **Untitled** at the top of the window and type a name for the new custom size.
5. Enter the height and width of the new custom size.
6. Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set the top, bottom, right, and left margins for User Defined margins.
7. To save the settings, click **OK**.

### Printing on Custom Paper Sizes

*Note:* Before printing on a custom paper size, use the Custom Paper Sizes feature in printer properties to define the custom size. For details, see *Defining Custom Paper Sizes* on page 88.

### Printing on Custom Paper Size Using Windows

1. Load the custom-size paper in the tray. For details, see *Loading Paper* on page 54.
2. In the application, click **File > Print** and select your printer.
3. In the Print dialog box, click **Properties**.
4. On the Printing Options tab, to select the desired custom size, use the **Paper** drop-down list.
   *Note:* If you are printing on custom size paper, define the custom size in the printer properties before printing.
5. From the Other Type drop-down list, select the paper type.
6. Select any other desired options, then click **OK**.
7. In the Print dialog box, click **OK** to start printing.

### Printing on Custom Paper Size Using Macintosh

1. Load the custom-size paper. For details, see *Loading Paper* on page 54.
2. In the application, click **Page Setup**.
3. From the Paper Size drop-down list, select the custom paper size.
4. Click **OK**.
5. In the application, click **Print**.
6. Click **OK**.
Copying

This chapter includes:

- Making Copies ................................................................. 92
- Adjusting Copying Options .................................................. 95
Making Copies

1. To clear previous control panel copy settings, press the **Clear All** button.
2. Load your original documents.
   - Use the document glass for single pages or paper that cannot be fed using the duplex automatic document feeder. Lift the duplex automatic document feeder, then place the original face down in the upper left corner of the document glass.
   - Use the duplex automatic document feeder for multiple or single pages. Remove any staples and paper clips from the pages, then place the pages face up in the duplex automatic document feeder. Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.
3. At the control panel, touch **Copy**.
4. Using the control panel keypad, enter the desired number of copies. The number of copies appears on the upper right corner of the display. To reset the number of copies to 1, press the **Clear** button.
5. Touch the copying option that you want to change. For details, see **Adjusting Copying Options** on page 95.
6. Press the **Start** button.
   The selected quantity of copies prints.
Document Glass Guidelines

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.).

To copy or scan the following types of originals, use the document glass rather than the duplex automatic document feeder.

- Paper with paper clips or staples attached
- Paper with wrinkles, curls, folds, tears, or notches
- Coated or carbonless paper or items other than paper such as cloth or metal
- Envelopes
- Books

Copying an ID Card

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied using the same location on the document glass. The printer stores both sides and prints them side by side on the paper.

To copy an ID card:

1. At the printer control panel, press the **Services Home** button.
2. Touch **ID Card Copy**.
3. For side 1, under the ID Card Copy tab, verify the paper supply, lightness/darkness, sharpness, and auto suppression background settings. Change the settings as needed.
4. Lift the document cover.
5. Place the ID card, or a document smaller than half the selected paper supply size, about 6 mm (.25 in.) from the upper left corner of the document glass.
6. Press the green **Start** button.
7. Lift the document cover.
8. For side 2, turn the document over and position it about 6 mm (.25 in.) from the upper left corner of the document glass.
9. Touch **Scan Side 2**.
10. To exit, press the **Services Home** button.
11. Remove the ID card from the scanner.
Duplex Automatic Document Feeder Guidelines

The duplex automatic document feeder accommodates the following originals:

- Width: 139.7–215.9 mm (5.5–8.5 in.)
- Length: 139.7–355.6 mm (5.5–14 in.)
- Weight:
  - 1-sided documents: 50–125 g/m²
  - 2-sided documents: 60–125 g/m²

Follow these guidelines when loading originals into the duplex automatic document feeder:

- Load originals face up so that the top of the document enters the feeder first.
- Place only loose sheets of paper in the duplex automatic document feeder.
- Adjust the paper guides so that they fit against the originals.
- Insert paper in the duplex automatic document feeder only when ink on the paper is dry.
- Do not load originals above the MAX fill line.
Adjusting Copying Options

This section includes:

- Basic Settings ................................................................. 96
- Image-Quality Settings .................................................. 97
- Output Adjustments ....................................................... 98

You can adjust numerous options for your copy jobs, specify characteristics of the original documents, and customize the output. For details, see Basic Copying.

You can also modify the default settings for many options. For details, see Selecting Default Copy Settings.
Basic Settings

This section includes:
- Selecting a Paper Tray ................................................................................................................................................... 96
- Making the Image Lighter or Darker ........................................................................................................................ 96
- Setting 2-Sided Copying................................................................................................................................................ 96

Selecting a Paper Tray
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
4. Touch a paper tray.
5. Touch OK.

Making the Image Lighter or Darker
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
4. To lighten or darken the image, touch the buttons to move the slider.
5. Touch OK.

Setting 2-Sided Copying
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Under the Copy tab, touch 2-Sided Copying.
4. Touch one of the following:
   - 1 - 1 Sided
   - 1 - 2 Sided
   - 2 - 1 Sided
   - 2 - 2 Sided
5. Touch OK.
Image-Quality Settings

This section includes:

- Specifying the Original Document Type ................................................................. 97
- Adjusting the Sharpness ............................................................................................. 97
- Auto Background Suppression .................................................................................... 97

Specifying the Original Document Type

To specify the type of the original document:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Quality tab.
4. Touch Original Type.
5. Touch one of the following:
   - Photo & Text for both photographs and text, such as magazines or newspapers. This is the default setting.
   - Text for black and white or colored text.
   - Photo for photographs.
6. Touch OK.

Adjusting the Sharpness

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Quality tab.
4. Touch Sharpness, then select an option.
5. Touch OK.

Auto Background Suppression

When copying originals printed on thin paper, text or images printed on one side of the paper can be seen on the other side. Use the Auto Background Suppression setting to reduce the sensitivity of the printer to variations in light background colors.

To adjust Auto Background Suppression:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Quality tab.
4. Touch Auto Background Suppression, then select an option.
5. Touch OK.
Output Adjustments

Collating Copies

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a six-page document, the copies are printed in this order:

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6

Uncollated copies print in the following order:

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6

To select a collating option:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Collation.
5. Touch one of the following:
   - **Auto** turns on collation only for originals placed in the duplex automatic document feeder. Originals placed on the document glass are not collated. This is the default setting.
   - **Collated** turns on collation for all copies made, regardless of where the originals are placed.
   - **Uncollated** turns off collation.
6. Touch OK.

Reducing or Enlarging the Image

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%.

To reduce or enlarge the copied image:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Reduce/Enlarge.
5. Touch one of the following:
   - To select a preset image size, touch a button.
   - To set the copy size in increments of 1%, touch the + or - buttons or use the keypad to set the percentage. The default setting is 100%.
6. Touch OK.
Printing Multiple Pages per Side

To print multiple pages per side:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Pages Per Side.
5. Touch one of the following:
   – Off copies one original image onto one side of a page. This is the default setting.
   – Auto copies two original pages, reduces the images, and prints them onto one side of a page.
   – Manual reduces the two original images as specified in Reduce/Enlarge, and prints them onto one side of a page.
6. Touch OK.

Adjusting the Edge Erase

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Edge Erase.
5. Select the desired edge, then to adjust, touch the (+) or (-) button.
6. Touch OK.
This chapter includes:

- Loading Documents for Scanning ................................................................. 102
- Scanning to a USB Flash Drive ...................................................................... 104
- Scanning to a Folder on a USB Connected Windows Computer .................. 105
- Scanning to a Folder on a USB Connected Macintosh Computer ................. 106
- Scanning to a Folder on a USB Connected Windows Computer .................. 107
- Scanning to an Email Address ...................................................................... 110
- Scanning to Web Services on Devices .......................................................... 111
- Scanning Images into an Application on a USB Connected Computer .......... 112
- Adjusting Scanning Settings ........................................................................ 114

See also:

Installation and Setup Overview on page 32
Loading Documents for Scanning

Position the original document as shown.

**Document Glass**
Lift the duplex automatic document feeder, then place the original face down in the upper left corner of the document glass.

**Duplex Automatic Document Feeder**
Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.

**Document Glass Guidelines**

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.). Use the document glass rather than the duplex automatic document feeder to copy or scan the following types of originals:

- Paper with paper clips or staples attached
- Paper with wrinkles, curls, folds, tears, or notches
- Coated or carbonless paper or items other than paper such as cloth or metal
- Envelopes
- Books
**Duplex Automatic Document Feeder Guidelines**

The duplex automatic document feeder accommodates the following originals:

- **Width:** 139.7–215.9 mm (5.5–8.5 in.)
- **Length:** 139.7–355.6 mm (5.5–14 in.)
- **Weight:**
  - 1-sided documents: 50–125 g/m²
  - 2-sided documents: 60–125 g/m²

Follow these guidelines when loading originals into the duplex automatic document feeder:

- Load originals face up so that the top of the document enters the feeder first.
- Place only loose sheets of paper in the duplex automatic document feeder.
- Adjust the paper guides so that they fit against the originals.
- Insert paper in the duplex automatic document feeder only when ink on the paper is dry.
- Do not load originals above the MAX fill line.
Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function produces scans in .jpg, .pdf, and .tiff file formats.

Note: Before pressing the Scan button or inserting the USB Flash drive, press the Power Saver button, then wait until the Power Saver indicator turns off.

To scan to a USB Flash drive:
1. Load the original on the document glass or in the duplex automatic document feeder.
2. Insert your USB Flash drive into the USB port on the front of the printer. The Scan to USB Memory tab appears on the touch screen.
3. To save the scanned file to a specific folder on the USB Flash drive, touch Change Folder.
4. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings on page 114.
5. To change folder and file options, touch Options.
6. To create a folder for the scanned file, touch Create Folder > On > OK.
7. To add a prefix or suffix to the file title, touch File Name.
   - To have the printer name the file automatically, touch Auto.
   - To add a prefix to the file name, touch Prefix, touch Enter Text, type the prefix name, then touch OK.
   - To add a suffix to the file name, touch Suffix, touch Enter Text, type the suffix name, then touch OK.
8. To begin the scan, press Start. The printer scans your images to the folder you specified.
9. If you are scanning from the document glass, when prompted, do one of the following:
   - To finish, touch Done, Save Now.
   - To scan another page, load a new original on the document glass, then touch Scan Another Page.

WARNING: Do not remove the USB Flash drive until prompted. If you remove the Flash drive before the transfer is complete, the file can become unusable and other files on the drive can be damaged.
Scanning to a Folder on a USB Connected Windows Computer

1. Click **Start** > **All Programs** > **Xerox Office Printing**.
2. From the list, select your computer, then double-click **Express Scan Manager**.
3. To accept the default Destination Path folder, click **OK**. To navigate to another folder, click **Browse**.
4. Click **OK**.
5. Load the original on the document glass or in the duplex automatic document feeder.
6. On the printer control panel, touch **Scan to**.
7. Touch **PC**.
8. Change scan settings as needed.
9. To begin the scan, press the **Start** button.

The printer scans your documents to the output destination specified in Express Scan Manager.
Scanning to a Folder on a USB Connected Macintosh Computer

1. Navigate to Applications > Xerox.
2. From the list, select your computer, then double-click Express Scan Manager.
3. To accept the default Destination Path folder, click OK. To navigate to another folder, click Browse.
4. Click OK.
5. Load the original on the document glass or in the duplex automatic document feeder.
6. On the printer control panel, touch Scan to.
7. Touch PC.
8. Change scan settings as needed.
9. To begin the scan, press the Start button.
   The printer scans your documents to the output destination specified in Express Scan Manager.
Scanning to a Shared Folder on a Network Computer

This section includes:

- Sharing a Folder on a Windows Computer ................................................................. 107
- Sharing a Folder Using Macintosh OS X Version 10.5 and Later .............................. 108
- Adding a Folder as an Address Book Entry Using CentreWare Internet Services .......... 108
- Adding a Folder as an Address Book Entry Using the Address Book Editor ............... 109
- Scanning to a Folder on a Network Computer ............................................................. 109

Before using the printer as a scanner on a network, you must:
1. Create a shared folder on your computer hard drive.
2. Create an address using CentreWare Internet Services or the Address Book Editor pointing the scanner to the computer.

   Note: For more information, see Connecting the Printer on page 34.

Sharing a Folder on a Windows Computer

1. Open Windows Explorer.
2. Right-click the folder you want to share, then select Properties.
3. Click the Sharing tab, then click Advanced Sharing.
4. Select Share this folder.
5. Click Permissions.
6. Select the Everyone group, and verify that all permissions are enabled.
7. Click OK.
   
   Note: Remember the Share name for later use.
8. Click OK again.
9. Click Close.
Sharing a Folder Using Macintosh OS X Version 10.5 and Later

1. From the Apple menu, select System Preferences.
2. From the Internet & Wireless menu, select Sharing.
3. From the Service menu, select File Sharing.
4. Under Shared Folders, click the plus icon (+).
5. Browse to the folder that you want to share on the network, then click Add.
6. To modify access rights for your folder, select it. The groups activate.
7. From the Users list, click Everyone, then use the arrows to select Read & Write.
8. Click Options.
9. To share the folder with Windows computers, select Share files and folders using SMB.
10. To share the folder with specific users, next to the user name, select On.
11. Click Done.
12. Close the System Preferences window.

   Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder and subfolders.

Adding a Folder as an Address Book Entry Using CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 27.
2. Click Address Book.
3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book.
4. Next to any empty field, click Add.
5. Enter the name to display in the address book.
6. For Server Type, select Computer (SMB).
7. For Host Address, type the IP address or DNS name for the server.
8. For Port Number, enter the default port number, or select a number from the range provided.
9. Type the Login Name that you use to access this computer. The printer uses this login name to access the shared folder.
10. To access the shared folder on the remote computer to save scanned files, for Password, type and confirm the password.
11. For Name of Shared Directory, type the name of the destination folder on the FTP server. For example, to save scanned files to a shared folder named scans, type scans.
12. For Subdirectory path, type the path of the folder as needed. For example, to save scans to a folder called colorscans that is one level below the scans folder, type /colorscans.
13. Click Save Changes.
Adding a Folder as an Address Book Entry Using the Address Book Editor

1. On your computer, select Start > All Programs > Xerox Office Printing > WorkCentre 3615 Address Book Editor.
2. In the left navigation pane, under Address Book, click Server.
3. For Name, enter the name of the shared file on your computer.
4. For Server Type, select Computer (SMB).
5. Click Computer Settings Wizard.
6. In the Computer Folder Settings window, click Browse.
7. Navigate to a shared folder on your computer.
8. Click Next.
9. When prompted to continue, click Yes.
10. In the Set Up Scanner Account window, click Next.
11. In the Confirmation window, click Finish.
12. In the Server Address window, click OK.
13. To save changes, when exiting, click Yes.

Scanning to a Folder on a Network Computer

1. Load the original on the document glass or in the duplex automatic document feeder.
2. On the printer control panel, touch Scan to.
3. Touch Network.
4. Touch the address book entry.
5. Touch OK.
6. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings on page 114.
7. To change folder and file options, touch Options.
8. To create a folder for the scanned file, touch Create Folder > On > OK.
9. To add a prefix or suffix to the file title, touch File Name.
   - To have the printer name the file automatically, touch Auto.
   - To add a prefix to the file name, touch Prefix, touch Enter Text, type the prefix name, then touch OK.
   - To add a suffix to the file name, touch Suffix, touch Enter Text, type the suffix name, then touch OK.
10. To begin the scan, press Start. The printer scans your image to the folder you specified.
11. If you are scanning from the document glass, when prompted, do one of the following:
   - To finish, touch Done, Save Now.
   - To scan another page, load a new original on the document glass, then touch Scan Another Page.
Scanning to an Email Address

Before scanning to an email address, set up the printer up with the email server information. For details, see the System Administrator Guide for your printer model:

To scan an image and send it to an email address:
1. Load the original on the document glass or in the duplex automatic document feeder.
2. At the control panel, touch Printer.
3. Specify the method for selecting recipients:
   - **New Recipient**: Allows you to enter the email address manually. To enter the address, use the keypad.
   - **Address Book**: Allows you to select an email address or a distribution list from the Address Book.
4. Touch OK.
5. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings on page 114.
6. To change folder and file options, touch Options.
7. To add a prefix or suffix to the file title, touch File Name.
   - To have the printer name the file automatically, touch Auto.
   - To add a prefix to the file name, touch Prefix, touch Enter Text, type the prefix name, then touch OK.
   - To add a suffix to the file name, touch Suffix, touch Enter Text, type the suffix name, then touch OK.
8. To begin the scan, press Start.
9. If you are scanning from the document glass, when prompted, do one of the following:
   - To finish, touch Done, Save Now.
   - To scan another page, load a new original on the document glass, then touch Scan Another Page.
Scanning to Web Services on Devices

Web Services on Devices (WSD) connect your computer to the printer. Use WSD to access scanned images at your computer.

Note: See Installing the Printer as a Web Service on Devices.

To scan to WSD:
1. Load the original on the document glass or in the duplex automatic document feeder.
2. On the printer control panel, touch Scan to.
3. Touch WSD.
4. To select a destination, touch the computer address.
5. To select the scan type, touch the Event field, then touch the scan type.
6. To begin the scan, press Start.
7. At the computer WSD Scan Device message, select a program to complete the scan.
Scanning Images into an Application on a USB Connected Computer

This section includes:
- Scanning an Image into an Application ................................................................. 112
- Scanning an Image Using Windows XP .................................................................... 112
- Scanning an Image Using Windows Vista or Windows 7 ......................................... 113

You can import images directly from the scanner into a folder on your computer. With a Macintosh computer, and some Windows applications, you can import the images directly into an application.

Scanning an Image into an Application

Note: Some Windows applications, including Office 2007, do not support this feature.

1. Open the file to insert the image.
2. In the file, select the insertion point for the image.
3. From the Windows toolbar, click Image > Picture > From Scanner or Camera.
4. From the Insert Image from Camera or Scanner window, select your device.
5. Click Custom Insert.
6. From the Basic Scanning tab, for Scan From, select an option.
7. To change any of the scanning settings, select them as needed.
8. To adjust crop lines, select Preview as needed.
9. Click Scan.

The printer scans the document and places the image in your application.

Scanning an Image Using Windows XP

1. On your computer, select Start > Control Panel.
2. On your computer, click Start > Settings > Control Panel > Printer and Other Hardware.
3. Double-click Scanners and Cameras.
4. In the Scanners and Cameras window, click Next.
5. Double-click Xerox WC3615.
6. Select an option:
   - Color picture
   - Grayscale picture
   - Black and white picture or text
   - Custom
7. Select the paper source:
   - Document Glass
   - Document Feeder
8. To preview the document or select a portion of the document to scan, select Preview. The printer scans a preview copy of the image.
9. To select a portion of the document to scan, click and drag the corner points to resize the frame.
10. Click Next.
11. Type a name for this group of pictures.
12. Select a file format.
13. Type a path name or browse to a location for the scanned images.
14. To save your image to the folder, in the Other Options window, select Nothing.
15. Click Next.
16. To view the scanned image, click the folder link in the window.
17. Click Finish.
   The image is stored in the folder and ready for use in your applications.

Scanning an Image Using Windows Vista or Windows 7
1. On your computer, select Start > All Programs > Windows Fax and Scan.
2. Click New Scan.
3. If prompted, select Xerox <ProdID>, then click OK.
4. Select the scan settings.
5. To preview the document or select a portion of the document to scan, select Preview. The printer scans a preview copy of the image.
6. To select part of the document, clear Preview or scan images as separate files, then to resize the frame, use the corner points.
7. Click Scan.
   The scanned image is stored in the default Scanned Documents folder or in a folder that you selected.
Adjusting Scanning Settings

This section includes:

- Setting the Output Color .............................................................. 114
- Setting the Scan Resolution .......................................................... 114
- Selecting 2-Sided Scanning ............................................................. 115
- Setting the File Format ................................................................. 115
- Making the Image Lighter or Darker ............................................. 115
- Adjusting the Sharpness ................................................................. 115
- Adjusting the Contrast ................................................................. 116
- Specifying the Original Size .......................................................... 116
- Erasing Edges ............................................................................. 116

You can modify the scan settings for individual jobs, once you select the scan mode.

You can also change the default values of some settings. For details, see Changing the Default Scan Settings.

Setting the Output Color

If the original image contains color, you can scan the image in color or in black and white. Selecting black and white significantly reduces the file size of the scanned images.

To set the output color:

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch Output Color.
4. Select a color mode.
5. Touch OK.

Setting the Scan Resolution

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both the size and image quality of the scanned image file. Higher scan resolution produces better image quality and a larger file size.
To set the scan resolution:
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch Resolution.
4. Select an option.
5. Touch OK.

Selecting 2-Sided Scanning

2-Sided Scanning scans both sides of the original image.

To set 2-sided scanning:
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch 2-Sided Scanning.
4. Touch 2-Sided.
5. To rotate the image on side 2 by 180 degrees, touch Rotate Side 2.
6. Touch OK.

Setting the File Format

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch File Format.
4. Touch a setting.
5. Touch OK.

Making the Image Lighter or Darker

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Quality tab.
4. Touch Lighten/Darken.
5. To lighten or darken the image, touch the buttons to move the slider.
6. Touch OK.

Adjusting the Sharpness

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Quality tab.
4. Touch Sharpness, then select an option.
5. Touch OK.
Adjusting the Contrast
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Quality tab.
4. Touch Contrast, then select an option.
5. Touch OK.

Specifying the Original Size
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Options tab.
4. Touch Original Size, then select a document size.
5. Touch OK.

Erasing Edges
You can erase content from the edges of your scans by specifying the amount to erase on the right, left, top, and bottom edges.

To use Erasing Edges:
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Options tab.
4. Touch Edge Erase, then touch the + or - buttons.
5. Touch OK.
This chapter includes:

- Configuring the Printer for Faxing ................................................................. 118
- Loading Documents for Faxing ................................................................. 119
- Sending a Fax from the Printer ................................................................. 120
- Sending a Delayed Fax ........................................................................... 121
- Sending a Cover Page with a Fax ............................................................... 122
- Sending a Fax From Your Computer ........................................................... 123
- Printing a Secure Fax ............................................................................... 125
- Polling a Remote Fax Machine ................................................................. 126
- Manually Sending, Receiving, or Polling Using OnHook ......................... 127
- Editing the Fax Address Book ................................................................. 128
Configuring the Printer for Faxing

Before you use the fax, you must configure the Fax Settings to make it compatible with your local connection and regulations. The Fax Settings include optional features you can use to configure the printer for faxing.

For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs.
Loading Documents for Faxing

Position the original document as shown.

**Document Glass**  
Lift the duplex automatic document feeder, then place the original face down in the upper left corner of the document glass.

**Duplex Automatic Document Feeder**  
Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.

*Note:* For details, see *Duplex Automatic Document Feeder Guidelines* on page 94.
Sending a Fax from the Printer

1. At the printer control panel, press the Services Home button.
2. Touch Fax.
3. Adjust fax settings as needed.
   - To adjust brightness, touch Lighten/Darken, then adjust as needed. Darken light originals, such as pencil images, and lighten dark images, such as halftone images, from newspapers or magazines.
   - To set the scan resolution, touch Resolution, then select an option.
   - To scan both sides of your original document, touch 2-Sided Scanning, then touch 2-Sided.
4. Enter a recipient fax number manually, or select an individual or group from the fax address book.
   - To enter a fax number manually, use the keypad. To insert a pause, press the Redial/Pause button (·). Press the Redial/Pause button multiple times to add additional pauses.
   - To add a number from the fax address book, touch the address book icon, then touch Device Address Book Individuals or Device Address Book Groups. Select the individual or group from the list, then touch OK.
   - To add numbers using Speed Dial, touch the orange telephone icon. Enter the speed dial number that is associated with the contact in the address book, then touch OK.
5. Press the green Start button.

**Note:** You can configure the printer to print a confirmation report after it transmits a fax. For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs.
Sending a Delayed Fax

1. At the printer control panel, press the **Services Home** button.
2. Touch **Fax**.
3. Add fax recipients and select fax settings as needed.
4. Touch **Options**.
5. Touch **Delayed Send**.
6. Touch **On**.
7. To enter the number of hours or minutes that the printer waits until sending the fax, touch **Hours** or **Minutes**, then use the keypad.
8. Touch **OK**.
9. Touch **Fax**.
10. Press the green **Start** button.

The fax is scanned and saved, then sent at the specified time.
Sending a Cover Page with a Fax

You can send a cover sheet with your fax. The cover sheet lists recipient information from the fax address book, and sender information from the Company Name Fax Line setting. For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs.

1. At the printer control panel, press the Services Home button.
2. Touch Fax.
3. Add fax recipients and select fax settings as needed.
4. Touch Options.
5. Touch Cover Page.
6. Touch On.
7. Touch OK.
8. Touch Fax.
9. Press the green Start button.
Sending a Fax From Your Computer

This section includes:
• Sending a Fax Using Windows Applications ........................................................................................................ 123
• Sending a Fax Using Macintosh Applications ...................................................................................................... 124

You can send a fax to the printer from an application on your computer.

Sending a Fax Using Windows Applications

You can send a fax from many Windows applications using the PCL 6 and PS drivers. You can use the Fax window to enter recipients, create a cover page with notes, and set options. You can set a confirmation sheet, send speed, resolution, send time, and dialing options.

1. With the desired document or graphic open in your application, open the Print dialog box. For most software applications, click File > Print or press CTRL+P.
2. Select your printer, then click Properties to open the print driver dialog box.
3. On the Printing Options tab, from the Job Type list, select Fax.
4. Click Recipients.
5. Do one or more of the following:
   – Click the Add From Phonebook button, then select a phonebook from the list. Select a name from the upper list, then add it to the Fax Recipients. To add more names, repeat the procedure. Click OK.
   – Click the Add Recipients button, type the recipient name and fax number, add other information, then click OK. Add new recipients as needed.
6. To include a cover sheet, click Cover Sheet, then from the Cover Sheet Options list, select Print a Cover Sheet.
7. On the Cover Sheet information tab, type notes that you want to appear on the cover sheet.
8. From the Image menu, then from the Watermark submenu, select Custom. For details, see Printing Watermarks on page 84.
9. On the Options tab, select the options for this fax.
10. Click OK.
11. In the Fax Properties window, click OK.
12. In the Print window, click OK.
   A Fax Confirmation sheet window appears.
13. Ensure that the recipient names and fax numbers are correct, then click OK.
Sending a Fax Using Macintosh Applications

You can send a fax from many Macintosh applications by using the fax driver. To install the fax driver, see Installing the Software on page 42.

1. Access the print settings in your software application. For most software applications, press CMD+P.
2. Select your LAN fax printer from the list.
3. To access the fax driver settings, select Fax Setting. The title of the button can vary depending on your application.
4. Modify fax settings as needed. For more information, click the Help (?) button.
5. Click Print.
6. Do one or more of the following:
   – Enter the recipient name and fax number, then click Add.
   – Click Look Up Address Book, select recipients from the local Address Book, or click Look Up Device Address Book and select recipients, then click Add.
7. Click OK.
8. To delay sending the fax, select Delayed Send, then enter the time that you want the fax to send.
9. Click Start Sending.
Printing a Secure Fax

When the Secure Receive setting is enabled, you must enter a password before faxes can be printed.

*Note:* Before you can receive a Secure Fax, enable the Panel Lock and Secure Fax features. For details, see the *System Administrator Guide* at [www.xerox.com/office/WC3615docs](http://www.xerox.com/office/WC3615docs).

1. At the printer control panel, press the **Job Status** button.
2. Touch **Secure Fax Receive**.
3. Enter the passcode.
4. Touch **OK**.
Polling a Remote Fax Machine

Fax Polling allows the printer to retrieve a fax stored on another fax machine that supports fax polling.

To retrieve a fax from another fax machine:
1. At the printer control panel, press the Services Home button.
2. Touch Fax.
3. Touch Options.
4. Touch Polling Receive.
5. Touch On.
6. Touch OK.
7. Touch Fax.
8. Enter the fax number of the fax machine to poll.
9. Press the green Start button.
Manually Sending, Receiving, or Polling Using OnHook

OnHook temporarily allows you to send, receive, or poll faxes manually. OnHook also turns on the fax modem speaker temporarily so you can hear the fax transmission sounds. This feature is helpful when dialing internationally, or when using phone systems that require you to wait for a specific audio tone.

Manually Sending, Receiving, or Polling Using OnHook

1. At the printer control panel, press the Services Home button.
2. Touch Fax.
3. Touch OnHook.
4. Touch Mode.
6. Enter a recipient fax number manually, enter a speed dial number, or select an individual from the fax address book.
   - To enter a fax number manually, use the keypad.
   - To insert a pause, press the Redial/Pause button (\-\). Press the Redial/Pause button multiple times to add additional pauses.
   - To add a number from the fax address book, touch the address book icon, then touch Device Address Book Individuals or Device Address Book Groups.
   - Select the individual or group from the list, then touch OK.
   - To add numbers using Speed Dial, touch the orange telephone icon. Enter the speed dial number that is associated with the contact in the address book, then touch OK.

   Note: You can add one fax number, one phone number, one speed dial number, or select one individual from the address book, manually, using OnHook.
7. Press the green Start button.
Editing the Fax Address Book

This section includes:

- Adding or Editing Contacts in the Fax Address Book in CentreWare Internet Services ...................... 128
- Adding or Editing Groups in the Fax Address Book in CentreWare Internet Services .......................... 128
- Adding or Editing Contacts in the Fax Address Book at the Control Panel .............................................. 129
- Adding or Editing Groups in the Fax Address Book at the Control Panel ................................................. 129
- Using the Address Book Editor Utility .................................................................................................. 129

You can create and save fax information for individual contacts or groups. Each contact is associated with a speed dial number. You can manage address book contacts in CentreWare Internet Services, at the control panel, or using the Address Book Editor utility.

Adding or Editing Contacts in the Fax Address Book in CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Address Book.
3. Under Fax, click Fax Address Book.
4. To add or edit a contact, next to the contact, click Add or Edit.
5. Type a name and fax number for the contact. To indicate a dialing pause, use a dash (-) character.
6. Click Save Changes.

Adding or Editing Groups in the Fax Address Book in CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Address Book.
3. Under Fax, click Fax Groups.
4. To add or edit a group, next to the group, click Add or Edit.
5. In Group Name, type a name for the group.
6. Click Save Changes.
7. Click Return.
8. To add a contact, click the group, then select each contact to add.
   
   **Note:** Before you can add a contact to a group, add the contact to the Fax address book.
9. Click Save Changes.
Adding or Editing Contacts in the Fax Address Book at the Control Panel

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings > Fax Address Book > Individuals**.
3. To add a contact, touch an unused contact, then touch **Edit**. To edit a contact, touch an existing contact, then touch **Edit**.
4. Touch **Name**, type a name, then touch **OK**.
5. Touch **Fax Number**, use the keypad to type a fax number, then touch **OK**. To insert a pause, press the **Redial/Pause** button (-).
6. Touch **OK**.

Adding or Editing Groups in the Fax Address Book at the Control Panel

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings > Fax Address Book > Groups**.
3. To add a group, touch an unused group, then touch **Edit**. To edit a group, touch an existing group, then touch **Edit**.
4. Touch **Enter Group Name**, type a name for the group, then touch **OK**.
5. To add contacts to the group, touch **Add from Address Book**.
6. Touch the contacts to add to the group, then touch **OK**.
7. Touch **OK**.

Using the Address Book Editor Utility

The Address Book Editor utility allows you to manage address book contacts at your computer.

To access the Address Book Editor utility:

- For Windows computers, select **Start > Programs > Xerox Office Printing > WorkCentre 3615 Address Book Editor**.
- For Macintosh computers, navigate to **Applications > Xerox > WorkCentre 3615**, then open **Address Book Editor**.
Maintenance

This chapter includes:

- Cleaning the Printer ................................................................. 132
- Ordering Supplies ................................................................. 136
- Managing the Printer ............................................................ 140
Cleaning the Printer

This section includes:

- General Precautions ......................................................................................................................................................132
- Cleaning the Exterior .................................................................................................................................................... 133
- Cleaning the Scanner ................................................................................................................................................... 133
- Cleaning the Interior ...................................................................................................................................................135

General Precautions

⚠️ CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. Do not touch or scratch the surface of the drum.

⚠️ CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed in this documentation.

⚠️ WARNING: Keep all cleaning materials out of the reach of children.

⚠️ WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners increase the risk of fire and explosion.

⚠️ WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

⚠️ WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open.

- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time, especially in well-lit places. Light exposure can damage the drum cartridge.
- Do not open covers and doors during printing.
- Do not tilt the printer while it is in use.
- Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print quality to deteriorate.
- Ensure any parts removed during cleaning are replaced before you plug in the printer.
**Cleaning the Exterior**

Clean the exterior of the printer once a month.

- Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
- After cleaning, wipe with a dry, soft cloth.
- For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain off.

⚠️ **CAUTION:** Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

**Cleaning the Scanner**

Clean the scanner about once a month, when anything is spilled on it, or when debris or dust collect on any of the surfaces. Keep the feed rollers clean to ensure the best possible copies and scans.

**Cleaning the Scanner**

1. Slightly dampen a soft, lint-free cloth with water.
2. Remove any paper or other media from the output tray.
3. Wipe the area under the scanner until it is clean.
4. Open the document cover.
5. Wipe the surface of the document glass until it is clean and dry.
   Note: For best results to remove marks and streaks, use Xerox glass cleaner.

6. Wipe the white underside of the document cover until it is clean and dry.

7. Close the document cover.
8. Open the duplex automatic document feeder top cover.

9. With a dry, soft lint-free cloth or paper towel, wipe the duplex automatic document feeder feed roller and the retard pad until they are clean.

Cleaning the Feed Rollers on the Duplex Automatic Document Feeder

1. Open the duplex automatic document feeder top cover.

2. With a dry soft lint-free cloth or paper towel, wipe the feed rollers and the retard pad until they are clean.

   Note: If the duplex automatic document feeder feed rollers and retard pad get stained with toner or debris, they can cause stains on the documents. To remove stains, use a soft lint-free cloth dampened with a neutral detergent or water.

Cleaning the Interior

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer regularly. Clean the printer interior whenever you replace the drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing the printer covers and doors.

- Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 159.
- Remove any dust or stains with a dry, clean cloth.

WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled.
Ordering Supplies

This section includes:

- Consumables ................................................................................................................................................................... 136
- Routine Maintenance Items ...................................................................................................................................... 136
- When to Order Supplies ............................................................................................................................................... 137
- Viewing Printer Supply Status ................................................................................................................................... 137
- Toner Cartridges ............................................................................................................................................................. 138
- Recycling Supplies .......................................................................................................................................................... 139

Consumables

Consumables are printer supplies that get depleted during the operation of the printer. The consumable supply for this printer is the genuine Xerox® Black Toner Cartridge.

Notes:

- Each consumable includes installation instructions.
- Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining amount displayed could be inaccurate.
- To ensure print quality, the toner cartridge has been designed to cease functioning at a predetermined point.

⚠️ CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

- Smart Kit Drum Cartridge
- Maintenance Kit, which includes a Fuser, Transfer Unit, and Feed Rollers
When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have replacements on hand. It is important to order these items when the messages first appear to avoid interruptions to your printing. An error message appears on the control panel when supplies must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/WC3615supplies.

⚠️ **CAUTION:** Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.

Viewing Printer Supply Status

You can check the status and percentage of life remaining for your printer supplies at any time using CentreWare Internet Services.

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press **Enter** or **Return**.
   
   **Note:** For details, see the *System Administrator Guide* at www.xerox.com/office/WC3615docs.

2. Select the **Status** tab.

3. Under Status, click **Supplies**.
Toner Cartridges

This section includes:

- General Precautions ................................................................. 138
- Replacing a Toner Cartridge ......................................................... 138

General Precautions

⚠️ **WARNINGS:**

- When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.
- Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child spit out the toner, and rinse out their mouth with water. Consult a physician immediately.
- Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner, contact your local Xerox representative.
- Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch fire and cause burn injuries or an explosion.

⚠️ **WARNING:** Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

- Do not open covers and doors during printing.
- Do not leave the covers and doors open for any length of time, especially in well-lit places. Light exposure can damage the drum cartridge.
- Do not place anything on top of the printer.
- Do not tilt the printer while it is in use.
- Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print quality to deteriorate.
- Ensure any parts removed during cleaning are replaced before you plug in the printer.

Replacing a Toner Cartridge

When a toner cartridge approaches the end of its usable life span, the control panel displays a toner low message. When a toner cartridge is empty, the printer stops and displays a message on the control panel.

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining amount displayed could be inaccurate.
Note: Each toner cartridge includes installation instructions.

<table>
<thead>
<tr>
<th>Printer Status Message</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toner Low</td>
<td>The toner cartridge is low. Order a new toner cartridge.</td>
</tr>
<tr>
<td>Toner Empty. Open the Front Cover. Then replace the Toner Cartridge.</td>
<td>The toner cartridge is empty. Open the front door and replace the toner cartridge.</td>
</tr>
</tbody>
</table>

**Recycling Supplies**

For more information on the Xerox® supplies recycling program, go to: [www.xerox.com/gwa](http://www.xerox.com/gwa).
Managing the Printer

This section includes:

- Checking Page Counts ................................................................. 140
- Adjusting Paper Type ................................................................. 141
- Adjusting the Transfer Unit ....................................................... 141
- Adjusting the Fuser ................................................................. 142
- Adjusting the Density .............................................................. 142
- Printing Charts ........................................................................ 142
- Cleaning the Developer ............................................................ 143
- Cleaning the Transfer Unit ....................................................... 143
- Refreshing the Toner ............................................................... 144
- Initializing the NVM ................................................................. 144
- Initializing the Print Meter ....................................................... 145
- Resetting the Transfer Unit ..................................................... 145
- Resetting the Fuser ............................................................... 145
- Clearing Storage .................................................................... 146
- Clearing Device Memory ....................................................... 146
- Adjusting the Altitude ............................................................. 146
- Decreasing Electrostatic Memory ........................................... 147
- Enabling Ghost Control ......................................................... 147
- Clearing Job History .............................................................. 147
- Adjusting the Touchscreen .................................................... 148
- Moving the Printer ................................................................ 148

Checking Page Counts

The Meter Readings menu shows the number of processed print jobs. The meter is divided according to the color mode. You cannot reset the meter readings; they track the total number of pages printed for the life of the printer.

You can check the total number of printed pages on the Configuration Report. It lists the print volume by the total number of pages printed on each paper size.
Printing the Configuration Report

1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages, then touch Configuration Report.
3. Touch Print.

Viewing Meter Readings

1. At the printer control panel, press the Machine Status button.
2. Touch Meter Readings.
3. After viewing the readings, touch X to close the window or press the Services Home button to return to the Services Home menu.

Adjusting Paper Type

Use Adjust Paper Type to compensate for paper thickness within a paper type. If the printed image is too light, use a heavier setting for the paper you are using. If the printed image is mottled or blotchy-looking, decrease the setting for the paper you are using.

To adjust the paper type:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Adjust Paper Type.
5. The default selection for Plain appears.
6. Touch Lightweight or Heavyweight, then press OK.

Adjusting the Transfer Unit

Adjusting the Transfer Unit can decrease a mottled appearance or white spots in your prints. This adjustment is available for each paper type.

Note: This setting affects print quality. The higher the value, the darker the printed output appears.

To adjust the transfer unit:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Adjust Transfer Unit.
5. Touch the paper for the adjustment, touch (-) or (+), then touch OK.
6. Repeat this procedure for each paper type you need to adjust.
7. To return to the Services Home menu, press the Services Home button.
**Adjusting the Fuser**

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is smearing or can be rubbed off the paper, increase the offset for the paper you are using. If the toner is blistered or mottled, decrease the offset for the paper you are using.

To adjust the fuser:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Adjust Fuser**.
5. Touch the paper for the adjustment, touch (-) or (+), then touch **OK**.

**Adjusting the Density**

The Density Adjustment feature controls how much toner is used to print. Adjust the density for lighter toner use for saving toner or heavier for making prints bolder. A positive adjustment makes the prints darker, while a negative adjustment makes the prints lighter. You can also adjust it to compensate for different paper types and thicknesses.

To adjust the density:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Adjust Density**.
5. Touch the desired density from Darken to Lighten, then press **OK**.

**Printing Charts**

The Charts feature prints different charts that you can use to help diagnose printing issues.

To print a chart:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Chart**.
5. Select an option:
   - **Pitch Chart**: Prints a full page halftone chart and a pitch measuring chart that you can use as a ruler to measure the distance between repeating defects. To identify the component causing the defect, compare the halftone chart, or your print sample, against the measurements shown on the chart.
   - **Full Page Solid**: Prints a 1-sided or 2-sided solid black chart that you can use to observe density variations.
   - **Alignment Chart**: Prints an image alignment chart that you can use to check image alignment on the page.

6. Touch **Print**.

### Cleaning the Developer

The Clean Developer feature runs the developer motor and stirs the toner in the toner cartridge. Use Clean Developer to clean toner from a cartridge just before changing it or to refresh the toner after replacing a toner cartridge.

To clean the developers:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Clean Developer**.
5. Touch **Start**.
   The process runs automatically and can take three minutes to complete.
6. The printer displays a message, then returns to the Services Home screen.

### Cleaning the Transfer Unit

The Clean Transfer Unit feature allows you to start motors that clean the bias transfer roller. You can use this feature if you observe toner on the back side of printed pages.

To clean the transfer unit:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Clean Transfer Unit**, then press **Start**.
   The process runs automatically and can take three minutes to complete.
   The printer displays a message, then returns to the Services Home screen.
**Refreshing the Toner**

You can use the Toner Refresh feature to use the last of the toner in a cartridge before you replace it, or to stir toner in a new cartridge.

To refresh the toner:

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Toner Refresh**.
5. Touch **OK**.
   The printer displays a message, then returns to the Services Home screen.
   
   **Note:** Do not use this procedure repeatedly. Running the procedure repeatedly uses the toner supply more quickly.

**Initializing the NVM**

Initializing the Non-Volatile Memory (NVM) restores the system settings to the factory default settings.

⚠️ **CAUTION:** Resetting NVM to the default erases all fax numbers, email addresses, and server addresses from the Address book.

To initialize the NVM:

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Initialize NVM**, then select an option.
5. Touch **Initialize**.
6. Touch **Yes, Initialize**.
   The printer displays a message, then returns to the Services Home screen.
**Initializing the Print Meter**

The Initializing the Print Meter feature resets the print meter count to zero.

To initialize the print meter:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Initialize Print Meter**.
5. Touch **Initialize**.
6. Touch **Yes, Initialize**.
   The printer displays a message, then returns to the Services Home screen.

**Resetting the Transfer Unit**

The Reset Transfer Unit feature resets the life counter after you replace the transfer unit.

To reset the transfer unit:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Reset Transfer Unit**.
5. Touch **Reset**.
6. Touch **Yes, Reset**.
   The printer displays a message, then returns to the Services Home screen.

**Resetting the Fuser**

The Reset Fuser feature allows you to reset the fuser life counter. Use this feature after you replace the fuser.

To reset the fuser:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Reset Fuser**.
5. Touch **Reset**.
6. Touch **Yes, Reset**.
   The printer displays a message, then returns to the Services Home screen.
Clearing Storage

The Clear Storage feature erases all data stored in the RAM disk or optional Device Memory, including all files stored as secure prints or saved jobs.

To clear storage:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Clear Storage.
5. Select an option:
   - All: Erases all Secure Print and Saved Job files.
   - Secure Jobs: Erases all Secure Print jobs.
   - Saved Jobs: Erases all Saved Job files.
6. Touch Clear.
7. Touch Yes, Clear.
   The printer displays a message, then returns to the Services Home screen.

Clearing Device Memory

The Clear Device Memory feature initializes the optional Device Memory.

To clear device memory:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Clear Device Memory.
5. Touch Start.
6. Touch Yes, Start.
   When the process is complete, the printer restarts automatically.

Adjusting the Altitude

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If the altitude setting is incorrect, it can cause print-quality problems.

To adjust the altitude:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Adjust Altitude.
5. Touch the altitude of the location of the printer, then press OK.
Decreasing Electrostatic Memory

The Decrease Electrostatic Memory feature reduces the instances of streaks along the edges of the printed output.

To enable Decrease Electrostatic Memory:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Decrease Electrostatic Memory.
5. Touch On, then touch OK.
6. To return to the Services Home menu, press the Services Home button.

Enabling Ghost Control

The Ghost Control feature reduces the instances of ghost images on the printed output.

To enable Ghost Control:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Decrease Ghosting.
5. Touch On, then touch OK.
6. To return to the Services Home menu, press the Services Home button.

Clearing Job History

The Clear Job History feature erases the history of all finished jobs.

To clear job history:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Clear Job History.
5. Touch Start.
6. Touch Yes, Start.
   The printer displays a message, then returns to the Services Home screen.
Adjusting the Touchscreen

The Adjust Touchscreen feature allows you to calibrate the touch positions on the touch screen.

To adjust the touch screen:

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Service Tools**.
4. Touch **Adjust Touchscreen**.
5. Read the instructions, then touch **OK**.
6. Touch each cross as it appears.
   
   **Note:** To improve the accuracy of the adjustment, to touch the center of each cross, use a stylus.
7. Touch **OK**.
8. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.

Moving the Printer

⚠️ **WARNINGS:**

- Always use at least two people to lift the printer.
- To prevent you from dropping the printer or injury, lift the printer firmly by gripping the recessed areas on both sides of the printer. Never lift the printer by gripping any other areas.
- If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. If the optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to the ground and cause injury.

Follow these instructions when moving the printer:
1. Always turn off the printer and wait for the printer to shut down.
2. Disconnect the power cord from the back of the printer.

⚠️ **CAUTION:** If the optional Device Memory is not installed, any saved jobs or held jobs in the active queue are deleted when the printer powers off.

⚠️ **WARNING:** To prevent electric shock, never touch the power plug with wet hands. When removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead to fire or electric shock.

3. Remove any paper or other media from the output tray. If the output tray extension is extended, close it.

4. Remove the paper from the paper tray.
   Keep the paper wrapped and away from humidity and dirt.
5. When lifting the printer, grasp the areas as shown.

![Warning symbol](image)

**Notes:**
- When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or right. Tilting the printer more than 10 degrees can cause toner spillage.
- When moving the printer over a long distance, remove the imaging units and toner cartridges to prevent toner from spilling. Repack the printer and its options using the original packing material and boxes or a Xerox Repackaging Kit. For a repacking kit and instructions, go to [www.xerox.com/office/WC3615support](http://www.xerox.com/office/WC3615support).

⚠️ **CAUTION:** Failure to repackage the printer properly for shipment can result in damage not covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by improper moving.

After moving the printer:
1. Reinstall any parts you removed.
2. Reconnect the printer to the cables and power cord.
3. Plug in and turn on the printer.
Troubleshooting

This chapter includes:

- General Troubleshooting.............................................................................................................................................152
- Paper Jams.......................................................................................................................................................................157
- Getting Help....................................................................................................................................................................182
General Troubleshooting

This section includes:

- Printer Does Not Turn On ............................................................................................................................................ 152
- Printer Resets or Turns Off Frequently ................................................................................................................... 153
- Printer Does Not Print ................................................................................................................................................... 154
- Printing Takes Too Long .............................................................................................................................................. 155
- Document Prints From Wrong Tray ........................................................................................................................ 155
- Automatic 2-Sided Printing Problems .................................................................................................................... 156
- Printer Makes Unusual Noises ................................................................................................................................... 156
- Paper Tray Does Not Close ......................................................................................................................................... 156
- Condensation Has Formed Inside the Printer ........................................................................................................... 156

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply restarting the printer.

Printer Does Not Turn On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power switch is not turned on.</td>
<td>Turn on the switch.</td>
</tr>
<tr>
<td>The power cord is not correctly plugged into the outlet.</td>
<td>Turn off the printer power switch, and plug the power cord securely into the outlet.</td>
</tr>
</tbody>
</table>
| Something is wrong with the outlet connected to the printer. | • Plug another electrical appliance into the outlet and see if it operates properly.  
  • Try a different outlet. |
| The printer is connected to an outlet with a voltage or frequency that does not match the printer specifications. | Use a power source with the specifications listed in the Electrical Specifications on page 192. |

⚠️ CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.
## Printer Resets or Turns Off Frequently

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power cord is not plugged into the outlet correctly.</td>
<td>Turn off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then turn on the printer.</td>
</tr>
<tr>
<td>A system error occurred.</td>
<td>Turn off the printer, then turn it on again. Print the Error History from the Information Pages of the Printer Setting Utility. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is connected to an uninterruptible power supply.</td>
<td>Turn off the printer, then connect the power cord to a suitable outlet.</td>
</tr>
<tr>
<td>The printer is connected to a power strip shared with other high-power devices.</td>
<td>Plug the printer directly into the outlet or into a power strip that is not shared with other high-power devices.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Printer Does Not Print

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer has an error.</td>
<td>To clear the error, follow the onscreen prompts. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is out of paper.</td>
<td>Load paper into the tray.</td>
</tr>
<tr>
<td>A toner cartridge is empty.</td>
<td>Replace the empty toner cartridge.</td>
</tr>
<tr>
<td>The Error Indicator is blinking.</td>
<td>• To clear the error, follow the onscreen prompts.</td>
</tr>
<tr>
<td></td>
<td>• If the Ready Indicator is off, the printer has stopped working.</td>
</tr>
<tr>
<td></td>
<td>Turn off the printer, then turn it on again. If the error persists,</td>
</tr>
<tr>
<td></td>
<td>contact your Xerox representative.</td>
</tr>
<tr>
<td>Both control panel indicators are off.</td>
<td>Turn off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then turn on the printer. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is busy.</td>
<td>• If the Ready Indicator is flashing, it is normal. A previous print job could be the problem. Use the printer properties to delete all print jobs in the print queue.</td>
</tr>
<tr>
<td></td>
<td>• Load the paper in the tray.</td>
</tr>
<tr>
<td></td>
<td>• If the Ready Indicator is not flashing after you send a print job, check the Ethernet connection between the printer and the computer.</td>
</tr>
<tr>
<td></td>
<td>• If the Ready Indicator is not flashing after you send a print job, check the USB connection between the printer and the computer. Turn off the printer, then turn it on again.</td>
</tr>
<tr>
<td>The printer cable is disconnected.</td>
<td>• If the Ready Indicator is not flashing after you send a print job, check the USB connection between the printer and the computer.</td>
</tr>
<tr>
<td></td>
<td>• If the Ready Indicator is not flashing after you send a print job, check the Ethernet connection between the printer and the computer.</td>
</tr>
</tbody>
</table>
## Printing Takes Too Long

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is set to a slower printing mode, for example, for printing on glossy or heavyweight paper.</td>
<td>It takes more time to print on certain types of special paper. Ensure that the paper type is set properly in the driver and at the printer control panel. For details, see Print Speed on page 193.</td>
</tr>
<tr>
<td>The printer is in Energy Saver mode.</td>
<td>Wait. It takes time for printing to start when the printer is coming out of Energy Saver mode.</td>
</tr>
<tr>
<td>The way the printer was installed on the network could be an issue.</td>
<td>Determine if a print spooler or a computer sharing the printer is buffering all print jobs and then spooling them to the printer. Spooling can slow print speeds. To test the speed of the printer, print some information pages such as the Office Demo Page. If the page does not print at the rated speed of the printer, there could be a network or printer installation issue.</td>
</tr>
<tr>
<td>The job is complex.</td>
<td>Wait. No action needed.</td>
</tr>
<tr>
<td>The print-quality mode in the driver is set to Enhanced.</td>
<td>Change the print-quality mode in the print driver to Standard.</td>
</tr>
<tr>
<td>The printer quality is set to Photo and the printer is being used for complex, 2-sided print jobs.</td>
<td>Increase memory size to 4 GB RAM by installing the optional Device Memory.</td>
</tr>
</tbody>
</table>

## Document Prints From Wrong Tray

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application and print driver have conflicting tray selections.</td>
<td>1. Check the tray selected in the print driver.</td>
</tr>
<tr>
<td></td>
<td>2. Go to the page setup or printer settings of the application from which you are printing.</td>
</tr>
<tr>
<td></td>
<td>3. Set the paper source to match the tray selected in the print driver or set the paper source to Automatically Select.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To have the print driver select the tray, set the tray used as the paper source to Auto Selection Enabled.</td>
</tr>
</tbody>
</table>
Automatic 2-Sided Printing Problems

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsupported or incorrect paper.</td>
<td>Ensure that you are using a supported paper size and weight for 2-sided printing. Envelopes and labels cannot be used for 2-sided printing. For details, see Supported Standard Types and Weights for Automatic 2-Sided Printing on page 52 and Supported Standard Paper Sizes for Automatic 2-Sided Printing on page 53.</td>
</tr>
<tr>
<td>Incorrect setting.</td>
<td>In the print driver Properties, select 2-Sided Print on the Paper/Output tab.</td>
</tr>
</tbody>
</table>

Printer Makes Unusual Noises

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is an obstruction or debris inside the printer.</td>
<td>Turn off the printer and remove the obstruction or debris. If you cannot remove it, contact your Xerox representative.</td>
</tr>
<tr>
<td>The Smart Kit Drum Cartridge is not fully seated.</td>
<td>Remove and reseat the Smart Kit Drum Cartridge.</td>
</tr>
</tbody>
</table>

Paper Tray Does Not Close

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray does not close fully.</td>
<td>• The paper tray lift plate is not locked down. Push down on the paper stack at the back of the tray until it locks down.</td>
</tr>
<tr>
<td></td>
<td>• Some debris or an object is blocking the tray.</td>
</tr>
</tbody>
</table>

Condensation Has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that is heated quickly.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer has been sitting in a cold room.</td>
<td>• Allow the printer to acclimate for several hours before operation.</td>
</tr>
<tr>
<td></td>
<td>• Allow the printer to operate for several hours at room temperature.</td>
</tr>
<tr>
<td>The relative humidity of the room is too high.</td>
<td>• Reduce the humidity in the room.</td>
</tr>
<tr>
<td></td>
<td>• Move the printer to a location where the temperature and relative humidity are within the operating specifications.</td>
</tr>
</tbody>
</table>
Paper Jams

This section includes:

- Locating Paper Jams ..................................................................................................................................................... 157
- Minimizing Paper Jams ................................................................................................................................................ 158
- Clearing Paper Jams ...................................................................................................................................................... 159
- Troubleshooting Paper Jams ..................................................................................................................................... 171
- Print-Quality Problems ................................................................................................................................................. 173
- Copy and Scan Problems ............................................................................................................................................. 178
- Fax Problems............................................................................................................................................................... 180

Locating Paper Jams

⚠️ WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled. If the error persists, contact your Xerox representative.

⚠️ CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Tray 2
2. Duplex Automatic Document Feeder
3. Fuser
4. Bypass Tray
5. Tray 1
Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper path.

The following can cause paper jams:

- Selecting the incorrect paper type in the print driver.
- Using damaged paper.
- Using unsupported paper.
- Loading paper incorrectly.
- Overfilling the tray.
- Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

- Use only supported paper. For details, see Supported Paper on page 50.
- Follow proper paper handling and loading techniques.
- Always use clean, undamaged paper.
- Avoid paper that is curled, torn, moist, creased, or folded.
- To separate the sheets before loading into the tray, fan the paper.
- Observe the paper tray fill line; never overfill the tray.
- Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.
- After loading the trays, select the correct paper type and size on the control panel.
- When printing, select the correct type and size in the print driver.
- Store paper in a dry location.
- Use only Xerox paper and transparencies designed for the printer.

Avoid the following:

- Polyester coated paper that is specially designed for inkjet printers.
- Paper that is folded, wrinkled, or excessively curled.
- Loading more than one type, size, or weight of paper in a tray at the same time.
- Overfilling the trays.
- Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/paper.
Clearing Paper Jams

This section includes:

- Clearing Paper Jams from the Duplex Automatic Document Feeder ..................................................159
- Clearing Paper Jams from the Bypass Tray .............................................................................................160
- Clearing Paper Jams from the Tray 1 Area ..............................................................................................163
- Clearing Paper Jams from the Tray 2 Area ..............................................................................................166
- Clearing Paper Jams from the Fuser Area ...............................................................................................168

Clearing Paper Jams from the Duplex Automatic Document Feeder

1. Remove the remaining paper from the duplex automatic document feeder.
2. Open the duplex automatic document feeder top cover.

3. If the paper is jammed in the exit of the duplex automatic document feeder, pull it out as illustrated.
4. To reset the interlock switch and clear the paper jam message, open and close the back door.

5. Reload the document in the duplex automatic document feeder, then adjust the guides against the edges of the paper.

**Clearing Paper Jams from the Bypass Tray**

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Remove any paper from the bypass tray.
2. Grasp both sides of the bypass tray, then pull it straight out of the printer.

3. Pull out the tray until it stops.

4. To remove the tray, lift the front of it slightly, then pull it out of the printer.

5. Remove the jammed paper.
6. To reset the interlock switch and clear the paper jam message, open and close the back door.

7. Insert tray 1 into the printer, then push it in all the way.

   Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.

8. Insert the bypass tray back into the printer. Push the tray in all the way.

9. If the control panel prompts you, on the screen, verify the paper size and type.
   a. Touch Size, then, for a standard paper size, touch an option.
   b. Touch Type, then, for the paper type, touch an option.

10. Touch OK.
Clearing Paper Jams from the Tray 1 Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Pull out the tray until it stops.

2. Grasp both sides of the bypass tray, then pull it straight out of the printer.

3. Pull out the tray until it stops.
4. To remove the tray, lift the front of it slightly, then pull it out of the printer.

5. Remove the jammed paper.

6. To reset the interlock switch and clear the paper jam message, open and close the back door.
7. Insert tray 1 into the printer, then push it in all the way.

*Note:* If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.

8. Insert the bypass tray back into the printer. Push the tray in all the way.

9. If the control panel prompts you, on the screen, verify the paper size and type.
   a. Touch **Size**, then, for a standard paper size, touch an option.
   b. Touch **Type**, then, for the paper type, touch an option.
   c. Touch **OK**.
Clearing Paper Jams from the Tray 2 Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Pull out tray 2 until it stops.

2. To remove the tray, lift the front of it slightly, then pull it out of the printer.

3. Remove any paper jammed at the front of the printer.
4. At the back of the printer, open the tray 2 door, then remove any paper jammed at the back of the printer.

5. To reset the interlock switch and clear the paper jam message, open and close the back door.

6. Insert tray 2 into the printer, then push it all the way in.

Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.

7. If the control panel prompts you, on the screen, verify the paper size and type.
   a. Touch Size, then, for a standard paper size, touch an option.
   b. Touch Type, then, for the paper type, touch an option.
   c. Touch OK.
Clearing Paper Jams from the Fuser Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. To open the rear door, pull the release and lower the cover.

2. If paper is jammed in the fuser, raise both green levers to open the fuser.

3. To open the paper guide, raise the green handle.
4. Remove any jammed paper from the back of the printer.

5. Close the paper guide on the fuser.

6. Lower the levers to their original position.
7. Remove any jammed paper from the back of the printer.

8. Close the rear door.
Troubleshooting Paper Jams

This section includes:

- Multiple Sheets Pulled Together ................................................................. 171
- Paper Misfeeds ........................................................................................................ 171
- Label and Envelope Misfeeds ........................................................................... 172
- Paper Jam Message Stays On ........................................................................... 172
- Jams During Automatic 2-Sided Printing ....................................................... 172

Multiple Sheets Pulled Together

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past fill line.</td>
</tr>
<tr>
<td>The edges of the paper are not even.</td>
<td>Remove the paper, align the edges, and then reload it.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the paper from the tray, and replace it with new dry paper.</td>
</tr>
<tr>
<td>Too much static electricity is present.</td>
<td>Try a new ream of paper.</td>
</tr>
<tr>
<td>Using unsupported paper.</td>
<td>Use only Xerox®-approved paper. For details, see Supported Paper on page 50.</td>
</tr>
<tr>
<td>Humidity is too high for coated paper.</td>
<td>Feed paper one sheet at a time.</td>
</tr>
</tbody>
</table>

Paper Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper is not correctly positioned in the tray.</td>
<td>• Remove the misfed paper and reposition it properly in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The paper guides are not correctly adjusted to the paper size.</td>
<td>Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The tray contains warped or wrinkled paper.</td>
<td>Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the moist paper and replace it with new, dry paper.</td>
</tr>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use only Xerox approved paper. For details, see Supported Paper on page 50.</td>
</tr>
</tbody>
</table>

Xerox® WorkCentre® 3615 Black and White Multifunction Printer
User Guide
## Label and Envelope Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The label sheet is facing the wrong way in the tray. | • Load label sheets according to the instructions from the manufacturer.  
• Load labels in the tray, face up.  
For details, see Loading Labels in Trays 1-4 on page 61 or Loading Labels in the Bypass Tray on page 69. |
| Labels are missing, curled, or pulled away from the backing sheet. | Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. |
| Envelopes are loaded incorrectly. | Load envelopes in the bypass tray only.  
For details, see Loading Envelopes in the Bypass Tray on page 69. |
| Envelopes are wrinkling. | • The heat and pressure of the laser printing process can cause wrinkling.  
• Use supported envelopes. For details, see Guidelines for Printing Envelopes on page 68. |

## Paper Jam Message Stays On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some paper remains jammed in the printer.</td>
<td>Recheck the media path and ensure that you have removed all of the jammed paper.</td>
</tr>
<tr>
<td>One of the printer doors is open.</td>
<td>Check the doors on the printer and close any door that is open.</td>
</tr>
<tr>
<td>The rear door interlock switch is not reset.</td>
<td>To reset the interlock switch and clear the paper jam message, open and close the back door.</td>
</tr>
</tbody>
</table>

Note: Check for, and remove, torn pieces of paper in the paper path.

## Jams During Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use paper of the correct size, thickness, or type. For details, see Supported Paper Sizes for Automatic 2-Sided Printing on page 53.</td>
</tr>
<tr>
<td>Paper is loaded in the wrong tray.</td>
<td>The paper must be loaded in the correct tray. For details, see Supported Paper on page 50.</td>
</tr>
<tr>
<td>Tray is loaded with mixed paper.</td>
<td>Load the tray with only one type and size of paper.</td>
</tr>
</tbody>
</table>
Print-Quality Problems

This section includes:

- Controlling Print Quality............................................................... 173
- Solving Print-Quality Problems.......................................................... 174

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/WC3615support.

⚠️ **CAUTION:** The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

**Note:** To ensure consistent print quality, the toner cartridges and imaging units for many models of equipment are designed to cease functioning at a predetermined point.

**Controlling Print Quality**

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal print quality is: 15–28°C (59–82°F) and 20–70% relative humidity.
Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:

- Use only Xerox approved paper. For details, see Supported Paper on page 50.
- Use only dry, undamaged paper.

⚠️ **CAUTION:** Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media

- Ensure the paper type selected in your print driver matches the paper type on which you are printing.
- If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the print driver.
- Store your paper and other media properly for optimum print quality. For details, see Paper Storage Guidelines on page 51.

Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and see the corresponding solution to correct the problem. You can also print a Demo Page to more precisely determine the print-quality problem.

If the print quality does not improve after carrying out the appropriate action, contact your Xerox representative.

**Note:** To maintain print quality, the toner cartridge is designed to provide a warning message when the toner level is low. When the toner cartridge reaches this level, a warning message appears. Once the toner cartridge is empty, another message prompts you to replace the toner cartridge. The printer stops printing until you install a new toner cartridge.
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The output is too light.                                                | • To check the toner level, check the control panel, use the print driver, or CentreWare Internet Services. If the toner cartridge is near empty, replace it.  
• Verify that the toner cartridge is approved for use in this printer, and replace it as needed. For best results, use a genuine Xerox toner cartridge.  
• Replace the paper with a recommended size and type, and confirm that your printer and print driver settings are correct.  
• Verify that the paper is dry and that supported paper is used. If not, change the paper.  
• Change the Paper Type settings in the print driver.  
  In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type setting.  
• Increase the Density Adjustment. For details, see Adjusting the Density on page 142.  
• If printer is located in a high altitude environment, adjust the altitude setting of the printer. For details, see Adjusting the Altitude on page 146. |
| Toner smears or print comes off. The output has stains on the back side. | • Change the Paper Type settings in the print driver. For example, change Plain to Lightweight Cardstock.  
  In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type setting.  
• Verify that the paper is the correct size, type, and weight. If not, change the paper settings.  
• Adjust the fuser. For details, see Adjusting the Fuser on page 142.  
• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary. For details, see Electrical Specifications on page 192. |
| Random spots on the output, or the image is blurry.                    | • Ensure that the toner cartridge is installed correctly.  
• If you used a non-genuine brand toner cartridge, install a genuine Xerox toner cartridge.  
• Use the Rough paper type setting, or try a paper with a smoother surface.  
• Ensure that the humidity in the room is within specifications. For details, see Relative Humidity on page 191. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The output is blank. | • Turn off the printer, then turn it on again.  
• If the error persists, contact your Xerox representative. |
| Streaks appear in the output. | • Replace the Smart Kit Drum Cartridge.  
• Contact your Xerox representative. |
| The output has a mottled appearance. | • Verify that the paper is the correct size, type, and weight. If not, change the paper settings.  
• Ensure that the humidity in the room is within specifications. For details, see Relative Humidity on page 191.  
• Adjust Transfer Unit to a lower value for the selected paper type. For details, see Adjusting the Transfer Unit on page 141.  
• Set the Adjust Transfer Unit setting to a higher value for the paper type. For details, see Adjusting the Transfer Unit on page 141. |
| Ghosting appears in the printed output. | • Verify that the paper is the correct size, type, and weight. If not, change the paper settings.  
• Change the Paper Type settings in the print driver.  
In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type setting.  
• Replace the Smart Kit Drum Cartridge.  
• Adjust the fuser. For details, see Adjusting the Fuser on page 142.  
• Enable Ghost Control. For details, see Enabling Ghost Control on page 147. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printed output is foggy.</td>
<td>Clean the developer. For details, see Cleaning the Developer on page 143.</td>
</tr>
<tr>
<td>Auger marks appear on the printed output.</td>
<td>• To check the toner level, check the control panel, use the print driver, or CentreWare Internet Services. If the toner cartridge is near empty, replace it.  &lt;br&gt;  • Verify that the toner cartridge is approved for use in this printer, and replace it as needed. For best results, use a genuine Xerox toner cartridge.  &lt;br&gt;  • Clean the developer. For details, see Cleaning the Developer on page 143.</td>
</tr>
<tr>
<td>The output print is wrinkled or stained.</td>
<td>• Verify that the paper is the correct size, type, and weight for the printer and that it is loaded properly. If not, change the paper.  &lt;br&gt;  • Try a new ream of paper.  &lt;br&gt;  • Change the Paper Type settings in the print driver.  In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type setting.</td>
</tr>
<tr>
<td>Envelopes are wrinkled or creased when printed.</td>
<td>Check if the crease is within 30 mm (1.2 in.) of the four edges of the envelope.  &lt;br&gt;  • If yes, it is printing as expected. Your printer is not faulty.  &lt;br&gt;  • If not, take the following actions:  &lt;br&gt;  Ensure that envelopes are loaded properly in the bypass tray. For details, see Loading Envelopes in the Bypass Tray on page 69.  &lt;br&gt;  Follow the guidelines for printing on envelopes. For details, see Guidelines for Printing Envelopes on page 68.  &lt;br&gt;  If the problem persists, use a different size envelope.</td>
</tr>
</tbody>
</table>
Symptom | Solutions
---|---
The top margin is incorrect. | • Ensure that the paper is loaded properly.  
• Ensure that the margins are set correctly in the application you are using.

The printed surface of the paper is bumpy. | 1. Print a solid image over the entire surface of one sheet of paper.  
2. Load the printed sheet into the tray with the printed side face down.  
3. Print five blank pages to remove debris from the fuser rollers.

The printed areas contain white spots. | Adjust Transfer Unit to a lower value for the selected paper type. For details, see Adjusting the Transfer Unit on page 141.

Toner streaks appear on the edges of prints. | Enable the Decrease Electrostatic Memory feature. For details, see Decreasing Electrostatic Memory on page 147.

**Copy and Scan Problems**

If the copy or scan quality is poor, refer to the following table.

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines or streaks present in copies only made from the document feeder.</td>
<td>There is debris on the document glass. When scanning, the paper from the document feeder passes over the debris creating lines or streaks. Clean all glass surfaces with a lint-free cloth.</td>
</tr>
<tr>
<td>Spots present in copies taken from the document glass.</td>
<td>There is debris on the document glass. When scanning, the debris creates a spot on the image. Clean all glass surfaces with a lint-free cloth.</td>
</tr>
<tr>
<td>The reverse side of the original is showing on the copy or scan.</td>
<td>Turn on Background Suppression.</td>
</tr>
</tbody>
</table>
| Image is too light or too dark. | • Copy: To lighten, darken, or adjust contrast, use the Image Quality settings.  
• Scan: To lighten, darken, or adjust contrast, use the Advanced Settings Tab. |

If the problem persists, for online support information, go to www.xerox.com/office/WC3615support.
Fax Problems

This section includes:

- Problems Sending Faxes......................................................................................................................... 180
- Problems Receiving Faxes.......................................................................................................................... 181

Note: If you cannot send and receive faxes, make sure that you are connected to an approved analog telephone line. The fax cannot send or receive when connected to a digital phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

Problems Sending Faxes

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The document is not scanned using the document feeder.</td>
<td>The document is too thick, too thin, or too small.</td>
<td>Use the document glass to send the fax.</td>
</tr>
<tr>
<td>The document is scanned at an angle.</td>
<td>The document feeder guides are not adjusted to the width of the document.</td>
<td>Adjust the document feeder guides to fit the width of the document.</td>
</tr>
<tr>
<td>The fax received by the recipient is blurry.</td>
<td>The document is incorrectly positioned.</td>
<td>Position the document correctly.</td>
</tr>
<tr>
<td></td>
<td>The document glass is dirty.</td>
<td>Clean the document glass.</td>
</tr>
<tr>
<td></td>
<td>The text in the document is too light.</td>
<td>Adjust the resolution. Adjust the contrast.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the telephone connection.</td>
<td>Verify that the telephone line is working, then send the fax again.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the fax machine of the caller.</td>
<td>Make a copy to verify that your printer is operating correctly. If the copy was printed correctly, have the recipient verify the condition of their fax machine.</td>
</tr>
<tr>
<td>The fax received by the recipient is blank.</td>
<td>The document was loaded incorrectly.</td>
<td>• Document feeder: Place the original document face up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Document glass: Place the original document face down.</td>
</tr>
<tr>
<td>Fax was not transmitted.</td>
<td>The fax number is wrong.</td>
<td>Verify the fax number.</td>
</tr>
<tr>
<td></td>
<td>The telephone line is incorrectly connected.</td>
<td>Verify the telephone line connection. If it is disconnected, connect it.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the fax machine of the recipient.</td>
<td>Contact the recipient.</td>
</tr>
<tr>
<td></td>
<td>The fax is not installed or is not enabled.</td>
<td>Verify that the fax is installed and enabled.</td>
</tr>
<tr>
<td></td>
<td>Server Fax is enabled.</td>
<td>Make sure that Server Fax is disabled.</td>
</tr>
</tbody>
</table>
Problems Receiving Faxes

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The received fax is blank.</td>
<td>There is a problem with the telephone connection or with the fax machine of the caller.</td>
<td>Verify that the printer can make clean copies. If it can, have the caller send the fax again.</td>
</tr>
<tr>
<td></td>
<td>The sender loaded the pages incorrectly.</td>
<td>Contact the sender.</td>
</tr>
<tr>
<td>The printer answers the call, but does not accept incoming data.</td>
<td>Not enough memory.</td>
<td>If the job contains several graphics, the printer could not have enough memory. The printer does not answer when memory is low. Delete stored documents and jobs then wait for the existing job to complete. This increases available memory.</td>
</tr>
<tr>
<td>The received fax size is reduced.</td>
<td>The paper supply in the printer does not match the document size sent.</td>
<td>Confirm the original size of the documents. Documents could be reduced based on the available paper supply in the printer.</td>
</tr>
<tr>
<td>Faxes cannot be received automatically.</td>
<td>The printer is set to receive faxes manually.</td>
<td>Set the printer to automatic reception.</td>
</tr>
<tr>
<td></td>
<td>The memory is full.</td>
<td>Load paper if it is empty, and then print the faxes stored in the memory.</td>
</tr>
<tr>
<td></td>
<td>The telephone line is incorrectly connected.</td>
<td>Verify the telephone line connection. If it is disconnected, connect it.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the fax machine of the sender.</td>
<td>Make a copy to verify that your printer is operating correctly. If the copy prints correctly, have the recipient verify their fax machine is operating correctly.</td>
</tr>
</tbody>
</table>

If the problem persists, for online support information, go to www.xerox.com/office/WC3615support.
Troubleshooting

Getting Help

This section includes:

- Control Panel Messages ................................................................. 182
- Using the Integrated Troubleshooting Tools ........................................ 183
- Online Support Assistant ................................................................. 184
- Information Pages ........................................................................... 184
- More Information ........................................................................... 184

Your printer comes with utilities and resources to help you troubleshoot printing problems.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning condition occurs, the control panel displays a message informing you of the problem. For many status and warning messages, the control panel Information provides additional information.

Control Panel Help

When a fault occurs that stops the printing operation, such as a paper jam, a message appears on the screen. A graphical illustration appears to indicate the location of the fault with a brief explanation of the action to take to clear the fault. The illustration changes to indicate multiple locations and actions to take.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, a message appears on the control panel to inform you of the problem. Warning messages inform you about printer conditions, such as low supplies or open doors, that require your attention. If more than one warning condition occurs, only one is displayed on the control panel.

Viewing Current Faults on the Control Panel

When a fault condition occurs, a message appears on the control panel to inform you of the problem. Fault messages warn you about printer conditions that prevent the printer from printing or degrade printing performance. If more than one fault occurs, only one is displayed on the control panel.
Viewing Job Status on the Control Panel

To view current or saved jobs on the control panel:
1. At the control panel, press the Job Status button.
   In the top portion of the screen, a list of current jobs appears.
2. To view a list of secure prints, touch Secure Jobs.
3. To view a list of secure faxes received, touch Secure Fax Receive.

To print a detailed list of last 20 print, copy, fax, or scan jobs that have processed:
1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Use the arrows to navigate the screens, then touch Job History.
4. Touch Print.

Using the Integrated Troubleshooting Tools

Your printer has a printable set of reports. Two of them, the Demo Page and the Error History report, can help with troubleshooting certain problems. The Demo Page prints an image to show the current ability of the printer to print. The Error History report prints information on the most recent printer errors.

Printing Reports
1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Use the arrows to navigate, then select a report.
4. Touch Print.

Specifying the Source Tray for Printing Reports
1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Tray Management > Tray Priority.
3. To specify a default source tray, select First, then select the tray from which to print reports.
4. Click OK.

Viewing Meter Readings
1. At the printer control panel, press the Machine Status button.
2. Touch Meter Readings.
3. After viewing the readings, touch X to close the window or press the Services Home button to return to the Services Home menu.
Online Support Assistant

Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/WC3615support.

Information Pages

Your printer has a printable set of information pages. These include configuration and font information, demonstration pages, and more.

More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Guide</td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Other documentation for your printer</td>
<td><a href="http://www.xerox.com/office/WC3615docs">www.xerox.com/office/WC3615docs</a></td>
</tr>
<tr>
<td>Recommended Media List</td>
<td>United States: <a href="http://www.xerox.com/paper">www.xerox.com/paper</a></td>
</tr>
<tr>
<td></td>
<td>European Union: <a href="http://www.xerox.com/europaper">www.xerox.com/europaper</a></td>
</tr>
<tr>
<td>Technical support information for your</td>
<td><a href="http://www.xerox.com/office/WC3615support">www.xerox.com/office/WC3615support</a></td>
</tr>
<tr>
<td>printer; including online technical</td>
<td></td>
</tr>
<tr>
<td>support, Online Support Assistant, and</td>
<td></td>
</tr>
<tr>
<td>driver downloads.</td>
<td></td>
</tr>
<tr>
<td>Information Pages</td>
<td>Print from the control panel, or from CentreWare Internet Services, click Status &gt; Information Pages.</td>
</tr>
<tr>
<td>CentreWare Internet Services documentation</td>
<td>In CentreWare Internet Services, click Help.</td>
</tr>
<tr>
<td>Order supplies for your printer</td>
<td><a href="http://www.xerox.com/office/WC3615supplies">www.xerox.com/office/WC3615supplies</a></td>
</tr>
<tr>
<td>A resource for tools and information,</td>
<td><a href="http://www.xerox.com/office/businessresourcecenter">www.xerox.com/office/businessresourcecenter</a></td>
</tr>
<tr>
<td>including interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs.</td>
<td></td>
</tr>
<tr>
<td>Local sales and support center</td>
<td><a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
<tr>
<td>Xerox® Direct online store</td>
<td><a href="http://www.direct.xerox.com/">www.direct.xerox.com/</a></td>
</tr>
</tbody>
</table>
Specifications

This appendix includes:

- **Printer Configurations and Options** ................................................................. 186
- **Physical Specifications** ....................................................................................... 188
- **Environmental Specifications** ............................................................................. 191
- **Electrical Specifications** ...................................................................................... 192
- **Performance Specifications** ................................................................................ 193
- **Controller Specifications** ................................................................................... 194
Printer Configurations and Options

Available Configuration

WorkCentre 3615DN: Network printer with copy, automatic 2-sided printing, scan, and fax functions and USB or network connectivity.

Standard Features

The Xerox® WorkCentre® 3615 Black and White Multifunction Printer provides the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Xerox® WorkCentre® 3615 Black and White Multifunction Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print speed</td>
<td>Standard mode up to 47 ppm for Letter and 45 ppm for A4</td>
</tr>
<tr>
<td>2-Sided print speed</td>
<td>Standard mode up to 28 ppm for Letter and 27 ppm for A4</td>
</tr>
<tr>
<td>Print resolution</td>
<td>• Standard print-quality mode</td>
</tr>
<tr>
<td></td>
<td>• Enhanced print-quality mode</td>
</tr>
<tr>
<td></td>
<td>• 600 x 600 dpi</td>
</tr>
<tr>
<td></td>
<td>• 1200 x 1200 dpi</td>
</tr>
<tr>
<td>Paper capacity</td>
<td>• Bypass Tray</td>
</tr>
<tr>
<td></td>
<td>• Tray 1</td>
</tr>
<tr>
<td></td>
<td>• Optional 550-Sheet Feeder</td>
</tr>
<tr>
<td></td>
<td>• 150 sheets</td>
</tr>
<tr>
<td></td>
<td>• 550 sheets</td>
</tr>
<tr>
<td></td>
<td>• 550 sheets</td>
</tr>
<tr>
<td>Maximum print size</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td>2-Sided Printing</td>
<td>Up to 163 g/m² from any tray (WorkCentre 3615DN model only)</td>
</tr>
<tr>
<td>Copy speed</td>
<td>• 1-sided copy</td>
</tr>
<tr>
<td></td>
<td>• 2-sided copy</td>
</tr>
<tr>
<td></td>
<td>• 45 copies per minute</td>
</tr>
<tr>
<td></td>
<td>• 28 copies per minute</td>
</tr>
<tr>
<td>Copy resolution</td>
<td>600 x 600 dpi</td>
</tr>
<tr>
<td>Maximum copy size</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td>Document feeder</td>
<td>Duplex Automatic Document Feeder</td>
</tr>
<tr>
<td>Document feeder capacity</td>
<td>60 sheets</td>
</tr>
<tr>
<td>Scan resolution</td>
<td>• Optical</td>
</tr>
<tr>
<td></td>
<td>• TWAIN</td>
</tr>
<tr>
<td></td>
<td>• WIA</td>
</tr>
<tr>
<td></td>
<td>• 1200 x 1200 dpi</td>
</tr>
<tr>
<td></td>
<td>• Up to 9600 dpi interpolated</td>
</tr>
<tr>
<td></td>
<td>• Up to 600 dpi</td>
</tr>
<tr>
<td>Maximum scan size</td>
<td>• Document Glass</td>
</tr>
<tr>
<td></td>
<td>• Duplex Automatic Document Feeder</td>
</tr>
<tr>
<td></td>
<td>• 215.9 x 355.6 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td></td>
<td>• 215.9 x 355.6 mm (8.5 x 14 in.)</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Xerox® WorkCentre® 3615 Black and White Multifunction Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File formats</strong></td>
<td>• JPEG</td>
</tr>
<tr>
<td></td>
<td>• TIFF</td>
</tr>
<tr>
<td></td>
<td>• PDF</td>
</tr>
<tr>
<td><strong>Supported scanning</strong></td>
<td>• Scan to SMB</td>
</tr>
<tr>
<td></td>
<td>• Scan to FTP</td>
</tr>
<tr>
<td></td>
<td>• Scan to Email</td>
</tr>
<tr>
<td></td>
<td>• Scan to USB</td>
</tr>
<tr>
<td></td>
<td>• Scan to Computer (USB)</td>
</tr>
<tr>
<td></td>
<td>• WSD Scan</td>
</tr>
<tr>
<td><strong>Email address book</strong></td>
<td>• Up to 100 email addresses</td>
</tr>
<tr>
<td></td>
<td>• Up to 10 email groups</td>
</tr>
<tr>
<td></td>
<td>• Up to 10 addresses per email group</td>
</tr>
<tr>
<td><strong>Control panel</strong></td>
<td>4.3 inch LCD touch screen and keypad navigation</td>
</tr>
<tr>
<td><strong>Connectivity</strong></td>
<td>• Universal Serial Bus (USB 2.0)</td>
</tr>
<tr>
<td></td>
<td>• USB Flash drive</td>
</tr>
<tr>
<td></td>
<td>• Ethernet 10/100/1000Base-T</td>
</tr>
<tr>
<td></td>
<td>• Wireless network connectivity: Optional</td>
</tr>
<tr>
<td><strong>Remote access</strong></td>
<td>CentreWare Internet Services</td>
</tr>
</tbody>
</table>

### Options and Upgrades
- Wireless network adapter
- 550-Sheet Feeder with up to 3 additional trays
- 4 GB Device Memory
Physical Specifications

Weights and Dimensions

<table>
<thead>
<tr>
<th></th>
<th>WorkCentre 3615DN</th>
<th>WorkCentre 3615DN with Optional 550-Sheet Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>49.5 cm (19.5 in.)</td>
<td>49.5 cm (19.5 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>49.2 cm (19.4 in.)</td>
<td>49.2 cm (19.4 in.)</td>
</tr>
<tr>
<td>Height</td>
<td>55.1 cm (21.7 in.)</td>
<td>64.6 cm (25.4 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>21.5 kg (47.4 lb.)</td>
<td>21.5 kg (47.4 lb.)</td>
</tr>
</tbody>
</table>

Standard Configuration
### Configuration Specifications with Optional 550-Sheet Feeder

**Total Space Requirements**

<table>
<thead>
<tr>
<th></th>
<th>WorkCentre 3615DN</th>
<th>WorkCentre 3615DN with Optional 550-Sheet Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong></td>
<td>99.5 cm (39.2 in.)</td>
<td>99.5 cm (39.2 in.)</td>
</tr>
<tr>
<td><strong>Depth</strong></td>
<td>149.2 cm (58.7 in.)</td>
<td>149.2 cm (58.7 in.)</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>87.4 cm (34.3 in.)</td>
<td>96.9 cm (38.1 in.)</td>
</tr>
</tbody>
</table>
Clearance Requirements

Xerox® WorkCentre® 3615 Black and White Multifunction Printer

Clearance Requirements with Optional 550-Sheet Feeder

Xerox® WorkCentre® 3615 Black and White Multifunction Printer
Environmental Specifications

Temperature

- Operating temperature: 10–32°C (50–90°F)
- Optimum temperature: 15–28°C (59–82°F)

Relative Humidity

- Minimum–Maximum Humidity Range: 10–85 %
- Optimal Humidity Range: 20–70 % relative humidity at 28°C (82°F)

Note: Under extreme environmental conditions, such as 10°C and 85 % relative humidity, defects can occur due to condensation.

Elevation

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).
Electrical Specifications

Power Supply Voltage and Frequency

<table>
<thead>
<tr>
<th>Power Supply Voltage</th>
<th>Power Supply Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>100–127 VAC +/-10 %, (90–140 VAC)</td>
<td>50 Hz +/- 3 Hz</td>
</tr>
<tr>
<td></td>
<td>60 Hz +/- 3 Hz</td>
</tr>
<tr>
<td>220–240 VAC +/-10 %, (198–264 VAC)</td>
<td>50 Hz +/- 3 Hz</td>
</tr>
<tr>
<td></td>
<td>60 Hz +/- 3 Hz</td>
</tr>
</tbody>
</table>

Power Consumption

- Energy Saver Mode (Sleep): 4W
- Ready, with fuser on: 59W
- Continuous printing: 698W

This printer does not consume electric power when the power switch is turned off even if the printer is connected to an AC outlet.

ENERGY STAR Qualified Product

The Xerox® WorkCentre® 3615 Black and White Multifunction Printer is ENERGY STAR® qualified under the ENERGY STAR Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European Union, and Japanese governments and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that result from generating electricity.

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Modes after 5 minutes from the last copy or print.
Performance Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer warm up time</td>
<td>Power on: As fast as 19.9 seconds.</td>
</tr>
<tr>
<td></td>
<td>Recovery from sleep mode: As fast as 9 seconds.</td>
</tr>
<tr>
<td></td>
<td>Note: Warm up time assumes an ambient temperature of 20°C (68°F) at 60% relative humidity.</td>
</tr>
</tbody>
</table>

Print Speed

Maximum print speeds for 1-sided continuous printing are 47 ppm for Letter (8.5 x 11”) and 45 ppm for A4 (210 x 297 mm).

Several factors affect print speed:

- 2-sided printing: The maximum print speeds for 2-sided continuous printing are 28 ppm for Letter (8.5 x 11”) and 27 ppm for A4 (210 x 297 mm).
- Print mode: Standard is the fastest print mode. Enhanced is half speed, or slower.
- Paper size. Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. Larger sizes reduce print speeds.
- Paper type: Plain prints faster than Rough Surface.
- Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.
Controller Specifications

Memory

<table>
<thead>
<tr>
<th>Memory</th>
<th>Xerox® WorkCentre® 3615 Black and White Multifunction Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard memory</td>
<td>1024 MB RAM</td>
</tr>
<tr>
<td>Device memory</td>
<td>4 GB Device Memory (optional)</td>
</tr>
<tr>
<td>Flash memory</td>
<td>64 MB ROM</td>
</tr>
<tr>
<td>EEPROM</td>
<td>64 KB EPROM</td>
</tr>
<tr>
<td>Fax memory</td>
<td>4 MB RAM</td>
</tr>
<tr>
<td>SRAM</td>
<td>128 KB</td>
</tr>
</tbody>
</table>

Interfaces

Universal Serial Bus (USB 2.0)
Ethernet 10/100/1000Base-TX
IEEE802.11 Compliant Wireless Network Adapter (optional)
Regulatory Information

This appendix includes:

- **Basic Regulations** ................................................................. 196
- **Copy Regulations** ................................................................. 200
- **Fax Regulations** ................................................................. 203
- **Material Safety Data Sheets** .............................................. 207
Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a residential environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

European Union

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the following applicable Directives of the European Union as of the dates indicated:

- December 12, 2006: Low Voltage Directive 2006/95/EC
This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

**European Union Lot 4 Imaging Equipment Agreement Environmental Information**

**Environmental Information Providing Environmental Solutions and Reducing Cost**

**Introduction**

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute

**Environmental Benefits of Duplex Printing**

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto enabled, during the setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the environmental impact of your work. However, should you require simplex/1-sided printing, you may change the print settings in the print driver.

**Paper Types**

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m²), which contains less raw material and thus save resources per print, may be used in certain applications. We encourage you to check if this is suitable for your printing needs.

**ENERGY STAR**

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the following website: www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used. This product is designed and configured to enable you to reduce your electricity costs. After the last print it switches to Ready Mode. In this mode it can print again immediately if required. If the product is not used for a period of time, the device switches to a Power Saver Mode. In these modes, only essential functions remain active in order to enable reduced product power consumption.

Upon exiting from Power Saver Mode, the first print will take slightly longer than in Ready Mode. This delay is the result of the system “waking up” from Power Saver mode and is typical of most imaging products on the market.

If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode, please consider that this device may then only switch to a lower energy level after a longer period of time or not at all.

To learn more about Xerox participation in sustainability initiatives, please visit our website at: www.xerox.com/about-xerox/environment/enus.html

Germany

Blendschütze

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Lärmemission

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder weniger gemäß EN ISO 7779.

Importeur

Xerox GmbH
Hellersbergstraße 2-4
41460 Neuss
Deutschland

Turkey RoHS Regulation

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yönetmeliğine uygundur.”
Regulatory Information for 2.4 GHz Wireless Network Adapter


Operation of this device is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the user’s authority to operate this equipment.
Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:
   - Certificates of Indebtedness.
   - National Bank Currency.
   - Coupons from Bonds.
   - Federal Reserve Bank Notes.
   - Silver Certificates.
   - Gold Certificates.
   - United States Bonds.
   - Treasury Notes.
   - Federal Reserve Notes.
   - Fractional Notes.
   - Certificates of Deposit.
   - Paper Money.
   - Bonds and Obligations of certain agencies of the government, such as FHA and so on.
   - Bonds. United States Savings Bonds may be photographed only for publicity purposes in connection with the campaign for the sale of such bonds.
   - Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled revenue stamp, this may be done provided the reproduction of the document is performed for lawful purposes.
   - Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be photographed, provided the reproduction is in black and white and is less than 75% or more than 150% of the linear dimensions of the original.
   - Postal Money Orders.
   - Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.
   - Stamps and other representatives of value, of whatever denomination, which have been or may be issued under any Act of Congress.
   - Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. Further information of these provisions may be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for Circular R21.
4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.
5. Passports. Foreign Passports may be photographed.
6. Immigration papers.
7. Draft Registration Cards.
8. Selective Service Induction papers that bear any of the following Registrant’s information:
   − Earnings or Income.
   − Court Record.
   − Physical or mental condition.
   − Dependency Status.
   − Previous military service.
   − Exception: United States military discharge certificates may be photographed.
9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the head of such department or bureau).

Reproducing the following is also prohibited in certain states:
   − Automobile Licenses.
   − Drivers’ Licenses.
   − Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your attorney.


Canada

Parliament, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

• Current bank notes or current paper money
• Obligations or securities of a government or bank
• Exchequer bill paper or revenue paper
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of law
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for a province)
• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a province, the government of a state other than Canada or a department, board, Commission, or agency established by the Government of Canada or of a province or of a government of a state other than Canada
• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province or by the government of a state other than Canada
• Documents, registers, or records kept by public officials charged with the duty of making or issuing certified copies thereof, where the copy falsely purports to be a certified copy thereof
• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on those found guilty of making such reproductions.

• Currency notes
• Bank notes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact your legal counsel.
Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including a fax machine, to send any message unless such message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message and the telephone number of the sending machine or such business, other entity, or individual. The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It connects to a compatible modular jack that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the compliant telephone line cord (with modular plugs) provided with the installation kit. See installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that can be connected to a line, as determined by the RENs, contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the codes in the following list:

- Facility Interface Code (FIC) = 02LS2
- Service Order Code (SOC) = 9.0Y
CAUTION: Ask your local Telephone Company for the modular jack type installed on your line. Connecting this machine to an unauthorized jack can damage telephone company equipment. You, not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could temporarily discontinue service to the telephone line to which it is connected. If advance notice is not practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone Company interrupts your service, they can advise you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could affect the operation of the equipment. If the Telephone Company changes something that affects the operation of the equipment, they should notify you in order for you to make necessary modifications to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for repair or warranty information. Contact information is contained in the Machine Status menu on the printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to the telephone network, the Telephone Company may request you to disconnect the equipment until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a qualified installer.

Canada

This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or alterations made by the user to this device, or device malfunctions, could cause the telecommunications company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected together. This precaution could be vital in rural areas.
**WARNING:** Do not attempt to make such connections yourself. Contact the appropriate electric inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of terminals allowed to be connected to a telephone interface. The termination on an interface could consist of any combination of devices. The only limitation to the number of devices is the requirement that the sum of the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the equipment.

**European Union**

**Radio Equipment and Telecommunications Terminal Equipment Directive**

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European single terminal connection to the public switched telephone network (PSTN). However, due to differences between the individual PSTNs provided in different countries, the approval does not give an unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal equipment for use on analog-switched telephone networks in the European Economic Area. This product provides a user-adjustable setting of the country code. The country code should be set prior to connecting this product to the network. Refer to the customer documentation for the procedure for setting the country code.

*Note:* Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we recommend that you set it to use DTMF signaling for more reliable and faster call setup. Modification of this product, connection to external control software, or connection to an external control apparatus not authorized by Xerox® will invalidate its certification.

**South Africa**

This modem must be used in conjunction with an approved surge protection device.

**New Zealand**

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection to its network. It indicates no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not imply that any Telepermitted product is compatible with all Telecom network services. Above all, it provides no assurance that any item will work correctly in all respects with another item of Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated. 33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such circumstances.
2. Immediately disconnect this equipment should it become physically damaged, then arrange for its disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is no guarantee that Telecom lines will always continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, do not contact the Telecom Faults Service.

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is readily available on almost all New Zealand telephone exchanges.

**WARNING:** No '111' or other calls can be made from this device during a mains power failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected to the same line.

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on the equipment (computer) associated with this device. The associated equipment shall be set to operate within the following limits for compliance with Telecom Specifications:

   For repeat calls to the same number:
   - There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual call initiation, and
   - The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the beginning of the next attempt.

   For automatic calls to different numbers:
   The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is no less than five seconds between the end of one call attempt and the beginning of another.

9. For correct operation, total of the RNs of all devices connected to a single line at any time should not exceed five.
Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
• North America: www.xerox.com/msds
• European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
Recycling and Disposal

This appendix includes:

- All Countries .....................................................................................................................................................................210
- North America ................................................................................................................................................................ .211
- European Union .............................................................................................................................................................. 212
- Other Countries ................................................................................................................................................................214
All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see www.dtsc.ca.gov/hazardouswaste/perchlorate.
Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal information, contact your local authorities.
European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.
Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used batteries, please take them to applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable resources and prevent any potential negative effects on human health and the environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact your local municipality, your waste disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes compliance with the requirements set out by the Directive.

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
Other Countries

Please contact your local waste management authority to request disposal guidance.